Commodity Query Energy Training Guide
# Table of Contents

**Chapter 1: Introduction**
- Objectives ....................................................................................................................... 1
- Overview of the Software .................................................................................................. 1
- Contents of Morningstar Commodity Data's Software Suite .............................................. 2
- Overview of the Database .................................................................................................. 2
- Starting Commodity Query ............................................................................................... 2

**Chapter 2: Getting Started with Commodity Query**
- Objectives ....................................................................................................................... 5
- Query Wizard Window ....................................................................................................... 5
  - Query Wizard SHOW Statement .................................................................................... 5
  - Query Wizard WHEN Statement .................................................................................. 7
- Query Builder Window ....................................................................................................... 8
  - Query Builder SHOW Statement .................................................................................. 8
  - Query Builder WHEN Statement .................................................................................. 9

**Chapter 3: Event-Driven Analysis using the Query Wizard Market Events**
- Synopsis .......................................................................................................................... 11
- Objectives .......................................................................................................................... 11
- Market Brief ....................................................................................................................... 11
- Problem .............................................................................................................................. 11
- Step-by-Step Solution ........................................................................................................ 12
- Language Lesson ............................................................................................................... 13
- Problem Solvers ................................................................................................................ 14

**Chapter 4: Event-Driven Analysis using the Query Wizard Date Events**
- Synopsis .......................................................................................................................... 15
- Objectives .......................................................................................................................... 15
- Market Brief ....................................................................................................................... 15
- Problem .............................................................................................................................. 15
- Step-by-Step Solution ........................................................................................................ 16
- Language Lesson ............................................................................................................... 18
- Problem Solvers ................................................................................................................ 18

**Chapter 5: Basic Pricing Graphs**
- Synopsis .......................................................................................................................... 19
- Objectives .......................................................................................................................... 19
- Market Brief ....................................................................................................................... 19
- Problem .............................................................................................................................. 20
- Step-by-Step Solution ........................................................................................................ 20
  - Choosing the Symbol and Column of Interest ............................................................... 20
  - Executing the Query ....................................................................................................... 22
  - Restarting or Clearing the Edit Pane ............................................................................... 24
- Language Lesson ............................................................................................................... 25
<table>
<thead>
<tr>
<th>Problem Solvers</th>
<th>82</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Lesson</td>
<td>81</td>
</tr>
<tr>
<td>Step-by-Step Solution</td>
<td>78</td>
</tr>
<tr>
<td>Excel Option Settings</td>
<td>87</td>
</tr>
<tr>
<td>Market Brief</td>
<td>87</td>
</tr>
<tr>
<td>Objectives</td>
<td>87</td>
</tr>
<tr>
<td>Synopsis</td>
<td>87</td>
</tr>
<tr>
<td>Excel Pane</td>
<td>88</td>
</tr>
<tr>
<td>Problem Solvers</td>
<td>88</td>
</tr>
<tr>
<td>Step-by-Step Solution</td>
<td>88</td>
</tr>
<tr>
<td>Chapter 17: Bringing Data into Excel from Commodity Query</td>
<td>87</td>
</tr>
<tr>
<td>Problem</td>
<td>87</td>
</tr>
<tr>
<td>Objectives</td>
<td>87</td>
</tr>
<tr>
<td>Market Brief</td>
<td>87</td>
</tr>
<tr>
<td>Synopsis</td>
<td>87</td>
</tr>
<tr>
<td>Excel Option Settings</td>
<td>87</td>
</tr>
<tr>
<td>Excel Pane</td>
<td>88</td>
</tr>
<tr>
<td>Problem Solvers</td>
<td>88</td>
</tr>
<tr>
<td>Step-by-Step Solution</td>
<td>88</td>
</tr>
<tr>
<td>Chapter 18: Problem Solver Answers</td>
<td>89</td>
</tr>
<tr>
<td>Problem Solver, Chapter 3: Event-Driven Analysis using the Query Wizard</td>
<td>89</td>
</tr>
<tr>
<td>Question</td>
<td>89</td>
</tr>
<tr>
<td>Answer</td>
<td>89</td>
</tr>
<tr>
<td>Problem Solver, Chapter 4: Event-Driven Analysis using the Query Wizard Date Events</td>
<td>89</td>
</tr>
<tr>
<td>Question</td>
<td>89</td>
</tr>
<tr>
<td>Answer</td>
<td>90</td>
</tr>
<tr>
<td>Problem Solver, Chapter 5: Basic Pricing Graphs</td>
<td>90</td>
</tr>
<tr>
<td>Questions</td>
<td>90</td>
</tr>
<tr>
<td>Answers</td>
<td>90</td>
</tr>
<tr>
<td>Problem Solver, Chapter 6: Limiting the Graph to a Relevant Period of Time</td>
<td>90</td>
</tr>
<tr>
<td>Questions</td>
<td>90</td>
</tr>
<tr>
<td>Answers</td>
<td>91</td>
</tr>
<tr>
<td>Problem Solver, Chapter 7: Using a Technical Indicator with a Price Graph</td>
<td>91</td>
</tr>
<tr>
<td>Questions</td>
<td>91</td>
</tr>
<tr>
<td>Answers</td>
<td>91</td>
</tr>
<tr>
<td>Problem Solver, Chapter 8: Basic Event-Driven Analysis using Date Conditions</td>
<td>92</td>
</tr>
<tr>
<td>Questions</td>
<td>92</td>
</tr>
<tr>
<td>Answers</td>
<td>92</td>
</tr>
<tr>
<td>Problem Solver, Chapter 9: Basic Event-Driven Analysis using Market Conditions</td>
<td>92</td>
</tr>
<tr>
<td>Questions</td>
<td>92</td>
</tr>
<tr>
<td>Answers</td>
<td>93</td>
</tr>
<tr>
<td>Problem Solver, Chapter 10: Event-Driven Analysis using Weather Data</td>
<td>93</td>
</tr>
<tr>
<td>Problem Solvers</td>
<td>82</td>
</tr>
<tr>
<td>Language Lesson</td>
<td>81</td>
</tr>
<tr>
<td>Step-by-Step Solution</td>
<td>78</td>
</tr>
<tr>
<td>Excel Option Settings</td>
<td>87</td>
</tr>
<tr>
<td>Market Brief</td>
<td>87</td>
</tr>
<tr>
<td>Objectives</td>
<td>87</td>
</tr>
<tr>
<td>Synopsis</td>
<td>87</td>
</tr>
<tr>
<td>Excel Option Settings</td>
<td>87</td>
</tr>
<tr>
<td>Excel Pane</td>
<td>88</td>
</tr>
<tr>
<td>Problem Solvers</td>
<td>88</td>
</tr>
<tr>
<td>Step-by-Step Solution</td>
<td>88</td>
</tr>
<tr>
<td>Chapter 17: Bringing Data into Excel from Commodity Query</td>
<td>87</td>
</tr>
<tr>
<td>Problem</td>
<td>87</td>
</tr>
<tr>
<td>Objectives</td>
<td>87</td>
</tr>
<tr>
<td>Market Brief</td>
<td>87</td>
</tr>
<tr>
<td>Synopsis</td>
<td>87</td>
</tr>
<tr>
<td>Excel Option Settings</td>
<td>87</td>
</tr>
<tr>
<td>Excel Pane</td>
<td>88</td>
</tr>
<tr>
<td>Problem Solvers</td>
<td>88</td>
</tr>
<tr>
<td>Step-by-Step Solution</td>
<td>88</td>
</tr>
<tr>
<td>Chapter 18: Problem Solver Answers</td>
<td>89</td>
</tr>
<tr>
<td>Problem Solver, Chapter 3: Event-Driven Analysis using the Query Wizard</td>
<td>89</td>
</tr>
<tr>
<td>Question</td>
<td>89</td>
</tr>
<tr>
<td>Answer</td>
<td>89</td>
</tr>
<tr>
<td>Problem Solver, Chapter 4: Event-Driven Analysis using the Query Wizard Date Events</td>
<td>89</td>
</tr>
<tr>
<td>Question</td>
<td>89</td>
</tr>
<tr>
<td>Answer</td>
<td>90</td>
</tr>
<tr>
<td>Problem Solver, Chapter 5: Basic Pricing Graphs</td>
<td>90</td>
</tr>
<tr>
<td>Questions</td>
<td>90</td>
</tr>
<tr>
<td>Answers</td>
<td>90</td>
</tr>
<tr>
<td>Problem Solver, Chapter 6: Limiting the Graph to a Relevant Period of Time</td>
<td>90</td>
</tr>
<tr>
<td>Questions</td>
<td>90</td>
</tr>
<tr>
<td>Answers</td>
<td>91</td>
</tr>
<tr>
<td>Problem Solver, Chapter 7: Using a Technical Indicator with a Price Graph</td>
<td>91</td>
</tr>
<tr>
<td>Questions</td>
<td>91</td>
</tr>
<tr>
<td>Answers</td>
<td>91</td>
</tr>
<tr>
<td>Problem Solver, Chapter 8: Basic Event-Driven Analysis using Date Conditions</td>
<td>92</td>
</tr>
<tr>
<td>Questions</td>
<td>92</td>
</tr>
<tr>
<td>Answers</td>
<td>92</td>
</tr>
<tr>
<td>Problem Solver, Chapter 9: Basic Event-Driven Analysis using Market Conditions</td>
<td>92</td>
</tr>
<tr>
<td>Questions</td>
<td>92</td>
</tr>
<tr>
<td>Answers</td>
<td>93</td>
</tr>
<tr>
<td>Problem Solver, Chapter 10: Event-Driven Analysis using Weather Data</td>
<td>93</td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>Problem Solver, Chapter 11: Event-Driven Analysis on Multiple Symbols</td>
<td>94</td>
</tr>
<tr>
<td>Problem Solver, Chapter 12: Analysis using Intraday Data</td>
<td>94</td>
</tr>
<tr>
<td>Problem Solver, Chapter 13: Event-Driven Analysis using Intraday Data</td>
<td>95</td>
</tr>
<tr>
<td>Problem Solver, Chapter 14: Back-Testing a Long-Only Moving Average Trading Strategy</td>
<td>95</td>
</tr>
<tr>
<td>Problem Solver, Chapter 15: Back-Testing Long &amp; Short Moving Average Trading Strategies</td>
<td>96</td>
</tr>
<tr>
<td>Problem Solver, Chapter 16: Using “My Queries” to Store Frequently Used Queries</td>
<td>97</td>
</tr>
<tr>
<td>Problem Solver, Chapter 17: Bringing Data into Excel from Commodity Query</td>
<td>98</td>
</tr>
<tr>
<td>Chapter 19: Glossary</td>
<td>101</td>
</tr>
<tr>
<td>Index</td>
<td>103</td>
</tr>
</tbody>
</table>
CHAPTER 1

Introduction

Objectives

1. Overview of the software.
2. Overview of the database.
3. How to start Commodity Query.

This manual is intended as an introduction to the Commodity Query research product. Each lesson contained within this manual is intended to familiarize you with the software and to demonstrate how the software may be used to perform meaningful market-driven research. For more information on the Commodity Query product, see the Commodity Query User Guide.

The format of each lesson is broken down into:

● a brief discussion about the market applicability of the specific program’s functionality to be learned within the lesson;

● an explanation of the problem to be solved within the lesson, step-by-step instruction on how to use the program to solve the problem;

● an overview of the program’s functions used within the lesson; and

● a set of ‘problem solvers’ which allow you to try out your new Commodity Query research skills.

Overview of the Software

Morningstar Commodity Data, Inc has a suite of research software products that allows a researcher to comprehensively analyze and forecast the markets. The software has an automatic link to an extensive database. This two-part package of the software and database will allow you to:

● create historical pricing graphs (example: a 52-week daily price graph of your security with bollinger bands);

● create event-driven analysis (example: seasonality studies); and

● back-test trading strategies (example: a historical profit and loss report generated from entry/exit conditions triggered by a moving average trading system).
Contents of Morningstar Commodity Data's Software Suite

Morningstar Commodity Data’s suite of research software includes the following:

- **Commodity Query**, A menu-driven interface designed to model and evaluate trade opportunities. The software uses a near-English query language to build queries (questions) about historical data.

- **Commodity Charts**, a software package that provides a point-and-click interface to access data on the Commodity DataServer. Use Commodity Charts to create comprehensive price graphs and charts, including technical analysis overlays and seasonality studies. Build formulas and easily do units of measure and currency conversions.

- **Commodity Add-in (Microsoft® Excel®)**, allows for easy data retrieval within an Excel spreadsheet.

- **Application Programming Interfaces (APIs)**, that include C/C++, Java, C#, VB .NET and the BMIM scripting language. These APIs create an open architecture which allows writing of custom applications to serve your special needs, as well accessing data with third-party products.

Overview of the Database

Morningstar Commodity Data time series data offerings include energy, equities, futures, fixed income, foreign exchange, economic indicators, weather data, daily price data for all domestic stocks traded at the NYSE, AMEX, and NASDAQ and OTC, daily data for U.S. and international futures contracts, U.S. treasury yield and auction data, daily foreign exchange data, U.S. and international index data, monetary and economic release data.

The Commodity DataServer server/database resides locally (on-site) and is updated every hour by default. While all of Morningstar Commodity Data’s clients receive the core data set, most of the clients select optional data packages that are relevant to their particular industry. The core data set contains, among other date series, daily pricing data for all energy future contracts, weather data and certain significant date data. For more information on the core and optional data offerings, please see the "Data" Web page (http://customers.lim.com/menu/data.htm).

Starting Commodity Query

For Commodity Query installation instructions, see the **Client Application Installation Guide**. The following information displays the first time Commodity Query is started and only needs to be entered once.

In order to run Commodity Query you will need to obtain a license key. Make a notation of the serial number listed in the License Installation window (example below). You will need to send this serial number to a Customer Support Representative at commoditydata-support@morningstar.com to obtain a license key.
Use **Ctrl+C** and **Ctrl+V** to copy/paste the license key number into the **License** field.

Next, enter the server and port information:
The Commodity Query interface displays.

The next time Commodity Query is restarted these screens will be by-passed. To change the server or port settings, select **Options > Connection > Server Config** from the menu bar once the Commodity Query interface displays.
Objectives

1. How does the software work?
2. Introducing the Query Wizard and the Query Builder.

Commodity Query is a user friendly software program designed to query a comprehensive historical database that includes, among other data series, security prices, volume, sentiment indicators, weather data and economic indicators. There are two basic types of queries that can be created within the program: the SHOW/WHEN query and the ORDER query.

SHOW/WHEN allows you to ask what happens to the data series when certain conditions hold true. The SHOW/WHEN query is an excellent research aid that allows users to understand, for example, how the price of their securities reacted historically to certain market conditions. The other type of query, ORDER, allows you to test trading ideas by placing buy or sell orders when certain conditions exist. Users often use the analysis prepared in the SHOW/WHEN query to develop trading strategies within their ORDER block queries.

A fast way to produce sophisticated queries for a new user to Commodity Query is to use the Query Wizard. This wizard allows the user to create queries using predefined market and date events. The Query Builder contains more advanced functionality and most of this book is dedicated to describing its features.

Query Wizard Window

Select the Query Wizard tab. Use the Query Wizard to create a query using the prebuilt list of market and date events. A user can go back and forth between the Query Builder and the Query Wizard to construct a query.

Query Wizard SHOW Statement

In the SHOW statement portion of the Query Wizard window the following query statement is listed:
The Query Wizard allows you to easily identify the type of study you want to apply, what increment of time should be studied and how far past your event dates the study should look. The fields are arranged so that a very understandable phrase like "show what happened in terms of percent move to IBM every day over the next two weeks" can be translated to the query language.

The following describes each of the five fields going from left to right:

- The first field has a choice of: **Total Return**, **Percent Move** or **Move** from the pull-down menu. This field will identify whether a total return, percentage move or move calculation is used to analyze the behavior from the event date to past the event date.

- The second field is where you enter the symbol name of the instrument you wish to study. You can also use the Search Database button to locate the symbol of choice.

- The third field designates what increment of time you want to analyze the movement of the symbol after the event dates. If you want to see what happens each day past the event date, this would be set to **Days**. Alternatively if you wanted to see the movement every week this would be set to **Weeks**. Use the pull-down menu to select **Days**, **Weeks**, **Months**, **Quarters**, **Years**, **Calendar Days**, **Calendar Weeks**, **Calendar Months**, **Calendar Quarters**, **Calendar Years**.

- The fourth and fifth fields designate how far past the event dates you want the study to look. If you want to study the 2 months past the event date set this to **2 months**. The number entry is either typed into the field or selected using the scroll arrows. Select the time period from the pull-down menu. The choices are: **Days**, **Weeks**, **Months**, **Quarters**, **Years**, **Calendar Days**, **Calendar Weeks**, **Calendar Months**, **Calendar Quarters**, **Calendar Years**.

- **Include what happened on the day** - Most of the Query Wizard SHOW statements have an implied time offset built into them. Check the Include what happened on the day check box to add a query statement with no time offset.

  For example (with check box unchecked):
  
  \[ t + 1: \text{\% move(IBM, from today to 1 Days later)} \]
  
  For example (with check box checked):
  
  \[ t: \text{1 day \% move of IBM} \\
  t + 1: \text{\% move(IBM, from today to 1 Days later)} \]
  
  The Include what happened on the day check box adds a query statement with no time offset.

**Query Wizard SHOW Statement Example**

Using the Query Wizard, it is possible to form a query that answers the following question:

How have Crude Oil Futures performed in the past after seeing a very big one-day gain, (which is more than two standard deviations stronger than the average one-day percentage change) which occurs three trading days after an OPEC meeting?

The following shows the SHOW pane entries:
The following shows the completed SHOW statement in the Edit pane of the Query Wizard window:

SHOW
  t+1: percent_move from today to 1 Days later of CL
  t+2: percent_move from today to 2 Days later of CL
  t+3: percent_move from today to 3 Days later of CL
  t+4: percent_move from today to 4 Days later of CL
  t+5: percent_move from today to 5 Days later of CL
  t+6: percent_move from today to 6 Days later of CL
  t+7: percent_move from today to 7 Days later of CL
  t+8: percent_move from today to 8 Days later of CL
  t+9: percent_move from today to 9 Days later of CL
  t+10: percent_move from today to 10 Days later of CL

Query Wizard WHEN Statement

The following shows the date events and the market events that may be applied to your query as conditions.

Date Event Description

The date events are made up of date files that contain dates for the meetings, report releases or other events that might affect the market. The date events allow users to anchor a variety of important market dates. The date events are located under the Date Events pane of the Query Wizard window.

For a description of each Date Event, see the "Date Events" appendix in the Commodity Query User Guide.

Date Event Example

Below is an example of a date file:

20060131
20060228
20060328
20060425
20060530
20060627
20060725
20060829
20060926
20061031

An example of the syntax resulting from selecting one of these events is displayed below.

WHEN
  Date is in "USA_TCB_Consumer_Confidence"
The syntax is saying the condition is true if the date is contained in the date file stored on the Commodity DataServer called "USA_TCB_Consumer_Confidence".

Market Event Description

Market events are pre-canned event conditions that can be easily added as WHEN statements to seek out dates when a particular market event occurred. These market events have been provided to allow users of all levels to write sophisticated queries without knowledge of the query language. The market events are located under the Market Event pane of the Query Wizard window.

For a description of the Market Events, see the "Market Events" appendix in the Commodity Query User Guide.

Market Event Example

For example, there is a market event available called Large five day decline located in the Big Moves folder in the Market Event pane of the Query Wizard window. The definition of a Large five day decline is an event where the closing price represents a five-day percentage decline of more than one standard deviation below the average five-day percentage change measured over the last 30 trading days. The syntax (see below) to accomplish this WHEN condition is somewhat complex and would typically take advanced Commodity Query query knowledge to write.

```
WHEN
  5 value percent_move ofTU is less than
  (30 day average of 5 value percent_move ofTU +
   1 * 30 day std_dev of 1 value percent_move ofTU)
```

Query Builder Window

The Query Builder window consists of the Edit pane and the SHOW WHEN panes. If you are familiar with the query language, you may type a query directly into the Edit pane. The SHOW WHEN panes allow you to create syntax through menu-driven selections. The following shows the components that make up the SHOW and WHEN statement portions of the Query Builder window.

Query Builder SHOW Statement

To build a query from scratch, the user must enter a symbol and column and select the Add Attribute to Query button. If you need to clear the Symbol and Column fields then select the Restart Attribute button and start over. Once the Add Attribute to Query button is selected, the query will display in the Edit pane. Use the buttons listed under the SHOW statement portion of the Query Builder window to modify the query. The following gives a
description of the buttons and their functions. For more information see the "SHOW/WHEN" chapter in the Commodity Query User Guide.

Table 2-1: SHOW Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>√</td>
<td>Studies</td>
</tr>
<tr>
<td></td>
<td>A study is a mathematical or statistical calculation of a data series. Some of the studies are macros which may be modified, saved and renamed using the macro editor.</td>
</tr>
<tr>
<td></td>
<td>Arithmetic Operators</td>
</tr>
<tr>
<td></td>
<td>Use the arithmetic operators: add, subtract, multiply, divide, power of to accomplish any mathematical formula.</td>
</tr>
<tr>
<td></td>
<td>Attribute Units</td>
</tr>
<tr>
<td></td>
<td>Attribute unit sets the default time frequency for any attribute expressions built in Commodity Query.</td>
</tr>
<tr>
<td></td>
<td>Edit Rollover</td>
</tr>
<tr>
<td></td>
<td>Use the choices in the Edit Rollover window to create custom futures contracts.</td>
</tr>
<tr>
<td></td>
<td>Time Offset</td>
</tr>
<tr>
<td></td>
<td>The Time Offset menu is used to pick a date, relative to ‘today’ or the current date executed within the system.</td>
</tr>
<tr>
<td></td>
<td>Profit Loss</td>
</tr>
<tr>
<td></td>
<td>Use the choices in the Profit Loss window to show statistics resulting from an ORDER query block.</td>
</tr>
<tr>
<td></td>
<td>IF-THEN-ELSE Statement (SHOW)</td>
</tr>
<tr>
<td></td>
<td>This language structure lets you assign values to your Attribute in the SHOW statement based on time, date, event or price conditions.</td>
</tr>
</tbody>
</table>

Query Builder WHEN Statement

Once the SHOW portion of the query is built, use the following buttons to build the WHEN portion of the query statement. The following gives a description of the buttons and their functions. For more information see the "SHOW/WHEN" chapter in the Commodity Query User Guide.

Table 2-2: WHEN Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Logical Operators</td>
</tr>
<tr>
<td></td>
<td>Multiple WHEN conditions in your query can be linked together into a complex condition using the And, Or, Xor, And Not, Or Not, Xor Not logical operators.</td>
</tr>
<tr>
<td></td>
<td>Date Time Condition</td>
</tr>
<tr>
<td></td>
<td>Use the settings in the Date Time Condition window to set either date or time conditions. Use the date choices to set historical date criteria. Use the time choices to set a particular time or range of times during the trading day.</td>
</tr>
<tr>
<td></td>
<td>Custom Event</td>
</tr>
<tr>
<td></td>
<td>Use the settings in the Custom Event window to search for conditions, events and patterns in price series. This menu is often used to specify certain market conditions.</td>
</tr>
<tr>
<td></td>
<td>Market Event</td>
</tr>
<tr>
<td></td>
<td>The Market Event window contains predefined events created by Morningstar Commodity Data.</td>
</tr>
<tr>
<td></td>
<td>IF-THEN-ELSE Statement (WHEN)</td>
</tr>
<tr>
<td></td>
<td>This language structure lets you assign values to a condition in your WHEN statement based on time, date, event or price conditions.</td>
</tr>
</tbody>
</table>
Repeat

This time saving feature is selected when you wish to repeat the WHEN condition statement for a continuous period of time.
CHAPTER 3

Event-Driven Analysis using the Query Wizard Market Events

Synopsis

Objectives

1. Using the SHOW statement.
2. Using market events.
3. Using time offsets.
4. Manually editing the syntax.

Market Brief

Event-driven analysis is often used to predict what might happen in the future based on what has happened in the past. Many analysts will do research to determine when a certain event or set of events occurred and then study how the market reacted in the following hours, days, weeks, months, or further. The SHOW WHEN query is designed to help the user answer the question: what happened in the past when this event occurred? Using the Query Wizard, it is possible to quickly and easily build and refine an event driven study.

Problem

You will take a look at what's happened in the past to the Crude Oil Futures contract traded on the NYMEX, when it crossed above its 200-day average and 1 day ago the close experiences a large five day decline.

Using the pre-built SHOW statement, the query will calculate the percentage move from each of our event dates to 1, 2, 3, 4, and 5 days past the event date. The Market Event pane in the Query Wizard window lists a variety of pre-canned conditions, including a “Large five day Decline”, that can be added to the query as a WHEN condition. You will select the market event called “Large Five Day Decline” and apply a time offset to specify that this decline occurred in
the 5 days prior to our event date. You will also select the market event called “Cross above 200-day Moving Average” as your anchor event.

After the query is completed, the following text will appear within the **Edit** pane of the **Query Wizard** window:

```plaintext
SHOW
  t+1: percent_move from today to 1 day later  of CL
  t+2: percent_move from today to 2 days later  of CL
  t+3: percent_move from today to 3 days later  of CL
  t+4: percent_move from today to 4 days later  of CL
  t+5: percent_move from today to 5 days later  of CL
 WHEN
  1 day ago
    5 value percent_move of CL  is less than
    (30 day average of 5 value percent_move of CL   -
    |1 * 30 day std_dev of 1 value percent_move of CL
    )
 AND
  CL crosses above 200 day average of CL
```

**Step-by-Step Solution**

Now you will step through the process of building this query using the Query Wizard.

1. Select the **Query Wizard** tab and in the **SHOW** pane select **Percent Move** from the first pull-down menu. In the next field (the Symbol field) select the **Search Database** button and select the **Tree View** tab. Open the folders for **Futures>Nymex** then right-click on the symbol **CL** and choose **Select and Close** to add the symbol to the **SHOW** statement and close the **Search Database** window.

2. Be sure that the field to the right of the symbol field is set to **Days**.

3. Next, in the **SHOW** pane change **Over the next 1 Days** to **Over the next 5 Days** by changing **1** to **5**. This will add new statements to the query (see below).

```plaintext
SHOW
  t+1: percent_move from today to 1 day later  of CL
  t+2: percent_move from today to 2 days later  of CL
  t+3: percent_move from today to 3 days later  of CL
  t+4: percent_move from today to 4 days later  of CL
  t+5: percent_move from today to 5 days later  of CL
```

Leave the box for **Include what happened on the day** unchecked. This setting is used when you want to add a query statement with no time offset.

4. For the **WHEN** statement, go to the **Market Event** pane and open the folder for **Big Moves** then select the check box for **Large Five Day Decline**. Select the **Occurred** button and choose **1 Day Ago**. The query statement updates (see below).

```plaintext
SHOW
```
t+1: percent_move from today to 1 day later of CL  
t+2: percent_move from today to 2 days later of CL  
t+3: percent_move from today to 3 days later of CL  
t+4: percent_move from today to 4 days later of CL  
t+5: percent_move from today to 5 days later of CL

WHEN
1 day ago
5 value percent_move of CL is less than
(30 day average of 5 value percent_move of CL -
(1 * 30 day std_dev of 1 value percent_move of CL)
)

The **Return** button will close the **Occurred** selection panel.

5. Next, as our anchor event, go to the **Market Event** pane and open the folder for **Cross-overs** then check the box for **Cross above 200-day Moving Average**. This selection completes the query (see below).

SHOW

| t+1: percent_move from today to 1 day later of CL |
| t+2: percent_move from today to 2 days later of CL |
| t+3: percent_move from today to 3 days later of CL |
| t+4: percent_move from today to 4 days later of CL |
| t+5: percent_move from today to 5 days later of CL |

WHEN
1 day ago
5 value percent_move of CL is less than
(30 day average of 5 value percent_move of CL -
(1 * 30 day std_dev of 1 value percent_move of CL)
)

AND
CL crosses above 200 day average of CL

**Language Lesson**

In this query, pre-canned event conditions were used from the **Query Wizard**. The definition of a **Large five day decline** is an event where the closing price represents a five-day percentage decline of more than one standard deviation below the average five-day percentage change measured over the last 30 trading days. The syntax to accomplish this **WHEN** condition is somewhat complex and would typically take advanced query knowledge to write.

WHEN
5 value percent_move of CL is less than (30 day average of 5 value percent_move of CL + (1 * 30 day standard_deviation of 1 value percent_move of CL))

This particular market event can be replicated in the **Query Builder** window using the **Custom Event** button which will be introduced in a later chapter. These market events are provided to allow users of all levels to write sophisticated queries easily. See the "Market Events" appendix in the **Commodity Query User Guide** for a description of each market event.
Problem Solvers

Create a query using the Query Wizard that shows what happens to the Natural Gas Futures contract 1 week and 2 weeks later when the close price is up extra big and the day before it made a new 52-week low.
CHAPTER 4

Event-Driven Analysis using the Query Wizard Date Events

Synopsis

Objectives

1. Using the SHOW statement.
2. Using date events.
3. Using the date time condition in the Query Builder.

Market Brief

Often, important report release dates can have an affect on the market. For instance the Weekly Natural Gas Storage Report produced by The EIA (Energy Information Administration) provides information on current storage inventory for natural gas. Gas is typically produced in more remote areas of the country and consumed at population centers. During warmer months, gas consumption declines, so excess pipeline capacity is used to ship gas for storage closer to market. When a cold spell hits in Winter gas in storage is extracted to help meet high demand. Storage levels are therefore an important indicator of the market’s readiness to meet demand and excite a lot of interest from market players when the report is released. There is also much speculation about change in storage levels in the run up to the report release. The gas market often reacts strongly when the storage report goes against expectations.

Problem

Let’s show what happened in the past to the Natural Gas Futures when in the fourth quarter, the Natural Gas Future was “up big” the day before the report and then “down big” the day of the report. Using the pre-built SHOW statement, the query will calculate the percentage move from each of our event dates to 1 and 2 weeks past the event date. The Date Event pane in the Query Wizard window contains a library of date files containing important report release dates, meeting dates, or other dates that may affect the market. You will select the EIA Gas Storage
report from the **Date Events** pane. You will also add a condition that will pull only dates in the fourth quarter from the **Date Time Condition** button in the **Query Builder** window.

After the query is completed, the following text will appear within the **Edit** pane of the **Query Wizard** window:

```
SHOW
  t+1: percent_move from today to 1 week later of NG
  t+2: percent_move from today to 2 weeks later of NG
WHEN
  Date is in "USA_EIA_Gas_Storage"
  AND
  1 value ago
    1 value percent_move of NG is more than
    (30 day average of 1 value percent_move of NG +
      1 * 30 day std_dev of 1 value percent_move of NG)
  AND
  1 value percent_move of NG is less than
    (30 day average of 1 value percent_move of NG -
      1 * 30 day std_dev of 1 value percent_move of NG)
  AND
  Date is fourth quarter
```

### Step-by-Step Solution

Now you will learn the steps for creating this query.

1. To begin, select the **Query Wizard** tab. In the **SHOW** pane select **Percent Move** from the first pull-down menu. In the next field (Symbol field) select the **Search Database** button and then select the **Tree View** tab. Open the folders for **Futures>Nymex** then right-click on the symbol **NG** and choose **Select and Close** to add the selection to the **SHOW** statement and close the **Search Database** window.

2. In the next field in the **SHOW** pane, change **every Days** to **every Weeks** by selecting **Weeks** from the pull-down menu. This completes the query statement portion from today to 1 week later.

3. The next portion of the **SHOW** pane **Over the next 1 Weeks** determines how many times the query statement is going to display. Change 1 to 2 and note how the query statement changes:

   ```
   SHOW
   t+1: percent_move from today to 1 week later of NG
   t+2: percent_move from today to 2 weeks later of NG
   ```

   Leave the box for **Include what happened on the day** unchecked. This setting is used when you want to add a query statement with no time offset.

4. Next, go to the **Date Event** pane, select the **By Type** tab and open the folder for **Energy**. Check the box for **Date is on USA_EIA_Gas_Storage**. The following shows your query progress:
SHOW 
  t+1: percent_move from today to 1 week later of NG 
  t+2: percent_move from today to 2 weeks later of NG 
WHEN 
  Date is in "USA_EIA_Gas_Storage"

5. Next, you need to show that the Natural Gas Future was “up big” the day before the report. To do this, go the Market Event pane and select the folder Ups & Downs. Check the box for Up Big then select the Occurred button. Change Days to Values and Occurred to Ago. Select the Return button to close the field. The Occurred button is now Occurred 1 Values Ago. The following shows your query progress:

SHOW 
  t+1: percent_move from today to 1 week later of NG 
  t+2: percent_move from today to 2 weeks later of NG 
WHEN 
  Date is in "USA_EIA_Gas_Storage" 
AND 
  1 value ago 
  1 value percent_move of NG is more than 
  (30 day average of 1 value percent_move of NG + 
  (1 * 30 day std_dev of 1 value percent_move of NG 
  ) )

6. Next, you need to show that the Natural Gas Future was “down big” the day of the report. To do this, go the Market Event pane and select the folder Ups & Downs. Check the box for Down Big. The following shows your query progress:

SHOW 
  t+1: percent_move from today to 1 week later of NG 
  t+2: percent_move from today to 2 weeks later of NG 
WHEN 
  Date is in "USA_EIA_Gas_Storage" 
AND 
  1 value ago 
  1 value percent_move of NG is more than 
  (30 day average of 1 value percent_move of NG + 
  (1 * 30 day std_dev of 1 value percent_move of NG 
  ) ) 
AND 
  1 value percent_move of NG is less than 
  (30 day average of 1 value percent_move of NG - 
  (1 * 30 day std_dev of 1 value percent_move of NG 
  ) )

7. The final query statement sets a condition that will pull only dates in the fourth quarter from the Date Time Condition button in the Query Builder. To do this, select the Query Builder tab and in the WHEN pane select the Date Time Condition button then select the Date or Time button and choose Date is from the pull-down menu. Select the within button and choose in Quarter>Fourth Quarter from the pull-down menu. Select the OK button to close the Date Time window and return to the Query Builder window. The following shows the completed query:

SHOW 
  t+1: percent_move from today to 1 week later of NG 
  t+2: percent_move from today to 2 weeks later of NG 
WHEN 
  Date is in "USA_EIA_Gas_Storage" 
AND 
  1 value ago 
  1 value percent_move of NG is more than 
  (30 day average of 1 value percent_move of NG + 
  (1 * 30 day std_dev of 1 value percent_move of NG 
  ) ) 
AND 
  1 value percent_move of NG is less than 
  (30 day average of 1 value percent_move of NG - 
  (1 * 30 day std_dev of 1 value percent_move of NG 
  ) )
Date is in “USA_EIA_Gas_Storage”
AND
1 value ago
1 value percent_move of NG is more than
(30 day average of 1 value percent_move of NG +
(1 * 30 day std_dev of 1 value percent_move of NG))
AND
1 value percent_move of NG is less than
(30 day average of 1 value percent_move of NG -
(1 * 30 day std_dev of 1 value percent_move of NG))
AND
Date is fourth quarter

Language Lesson

This query utilizes the date events in the Query Wizard. The date events are made up of date files that contain dates for the meetings, report releases or other events. Below is an example sample of a date file.

…20060131
20060228
20060328
20060425
20060530
20060627
20060725
20060829
20060926
20061031...

The syntax resulting from selecting one of these events is displayed below.

WHEN
  Date is in “USA_EIA_Gas_Storage”

The syntax is saying the condition is true if the date is contained in the date file stored on the Commodity DataServer server called “Date is in “USA_EIA_Gas_Storage”. This might explain why the syntax does not more directly state “Date is EIA Gas Storage report release”.

You also practiced going to the Query Builder window to add a condition. Any attribute or condition can be added to a query built with the Query Wizard.

Problem Solvers

Create a query using the Query Wizard that shows what happens to the Crude Oil Futures contract each day over the next 3 days when the EIA (formerly DOE) Petroleum report comes out.
CHAPTER5

Basic Pricing Graphs

Synopsis

Objectives

1. Introducing SHOW attributes.
2. Using continuous futures contracts.
3. Executing a query.
4. Restarting or saving a query.

Market Brief

The most commonly used market research tool is a price graph or chart. Price graphs may be employed to determine where the current price of a security is in relationship to the prices the security made for some relevant period of time by displaying the historical activity for a security. For example, did the security reach a new 1-month high or is the security priced uncommonly low compared to the prices attained over the last year?

The “Money & Investing” section of The Wall Street Journal contains price graphs for certain major investment sectors. For example, this newspaper will graphically display the daily closing price for the Dow Jones Industrial Average for the last two calendar years. Commodity Query allows a user to construct this type of research by building a query. The type of query that graphs price history for an investment is easy to construct. Queries, as mentioned earlier, are English-like questions created about a database consisting of time series data. In the Commodity Query language the query will show the daily closing price of a security when the date falls within the last two years. Using a SHOW attribute in the Query Builder to build this query, it is necessary to select the symbol (the security of interest) and the column or data series that relates to that symbol (the closing price). This combination of a symbol + a column is a complete description of a times series and the simplest form of what will be referred to as an attribute. Next, the query can be limited to some relevant period of time (e.g., within 2 years) by adding a date condition. These concepts will become clearer as we continue to work through the materials in the manual.
Problem

We can create a similar price graph for our security of interest. The New York Mercantile Exchange (NYMEX) lists the Henry Hub natural gas futures contract. The most active or liquid contract is the contract that has the nearest expiration date (commonly referred to as the front contract).

For this lesson, you will create an historical graph of the daily closing price of the front continuous contract. You will capture the price history for all contracts that appear on the NYMEX as the nearest to expire. Our query, when executed as a graph, will display every closing price for the natural gas contract when the contract trades as the nearest to expire. This pricing chain, made up of several different contracts over time, will not be shown as an adjusted price series but rather will display the prices as traded.

In order to construct this type of query, we will use the SHOW/WHEN query block to define a simple SHOW attribute. This query will SHOW the daily closing price for the front Henry Hub natural gas contract. A query, such as the one used in this lesson, that has a SHOW attribute without a WHEN condition will return all values available for the attribute from the database. The addition of a WHEN condition to a query will simply narrow down the data population.

After you have completed the query, the following text will appear within the Edit pane of the Query Builder window:

```
SHOW
  1: Close of NG
```

Step-by-Step Solution

Choosing the Symbol and Column of Interest

1. You need to define your SHOW attribute by defining our symbol and column of interest.

2. To add a symbol name you can either enter the symbol of interest by typing it into the text field located next to Symbol or by selecting Search Database icon to look up the symbol. The Search Database is used like a dictionary look-up feature and will allow you to easily find the proper symbol name. For this example, select the Search Database icon to look up the symbol.

3. In the Search Database window under the Tree View tab, open the folders for: Futures>Nymex. Notice that with each subsequent selection, the directory path displays at the bottom of the window.

4. Select NG, right-click and choose Select to complete the symbol selection. The symbol and its default column are entered in the SHOW pane of the Query Builder window. Notice that the description of the contract appears in the description field to verify that the correct selection was made.
Select **OK** to close the **Search Database** window and return to the **Query Builder** window.

5. The selected symbol should now appear in the **Symbol** text field.
NG is a continuous series. If you were adjusting the rollover policy for this contract you would use the Edit Rollover button.

6. The next step involves selecting the data series or column that relates to the symbol. The software will default to the most commonly used column, such as the Close, where no column is specified. To specify a column, select the pull-down for the Column field and select a column. For this example, keep the column Close. Select the Add Attribute to Query button to add the SHOW statement to the Edit pane.

Executing the Query

1. The results of the newly created query may be obtained by selecting the Report or Graph buttons located in the toolbar. First select Report. Notice that the results are displayed in tabular format. All dates, which have a closing price for the security in the database, will be listed on the left-most column and the closing price for the front natural gas futures contract listed in the column to the right of the date. If a WHEN condition was added to the query, only those dates that met that condition would be returned.

Notice that a few dates reflect NaN in the close column. NaN stands for not a number and will appear anytime a price is not available because the markets are closed (i.e., a holiday) or the designated data vendor did not supply this data. A few descriptive statistics appear at the bottom of our report to categorize our data population.
<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/26/2006</td>
<td>Thu</td>
<td>6.2480</td>
</tr>
<tr>
<td>12/29/2006</td>
<td>Fri</td>
<td>6.2990</td>
</tr>
<tr>
<td>01/01/2007</td>
<td>Mon</td>
<td>NaN</td>
</tr>
<tr>
<td>01/02/2007</td>
<td>Tue</td>
<td>NaN</td>
</tr>
<tr>
<td>01/03/2007</td>
<td>Wed</td>
<td>6.1630</td>
</tr>
<tr>
<td>01/04/2007</td>
<td>Thu</td>
<td>6.1620</td>
</tr>
<tr>
<td>01/05/2007</td>
<td>Fri</td>
<td>6.1840</td>
</tr>
<tr>
<td>01/08/2007</td>
<td>Mon</td>
<td>6.3780</td>
</tr>
<tr>
<td>01/09/2007</td>
<td>Tue</td>
<td>6.6310</td>
</tr>
<tr>
<td>01/10/2007</td>
<td>Wed</td>
<td>6.7550</td>
</tr>
<tr>
<td>01/11/2007</td>
<td>Thu</td>
<td>6.2920</td>
</tr>
<tr>
<td>01/12/2007</td>
<td>Fri</td>
<td>6.6010</td>
</tr>
</tbody>
</table>

- **Avg**: 3.5345
- **AvgPos**: 3.5345
- **AvgNeg**: NaN
- **PctPos**: 100.0000
- **PctNeg**: 0.0000
- **Maximum**: 15.3780
- **Minimum**: 1.0460
- **StdDev**: 2.3749
- **ZStat**: 1.4883
- **Variance**: 5.6400

4379 Occurrences
2. Select **Dismiss** at the bottom of the **Report** window and select the **Graph** button from the toolbar to see the answers displayed graphically (see below).

Select the **Dismiss** button to close the graph and return to the **Query Builder**.

The **Options** button in the **Graph** window controls the display settings for the graph. These option settings are defined in the "Analysing Your Research Results" chapter in the **Commodity Query User Guide**.

**Restarting or Clearing the Edit Pane**

To clear the **Edit** pane for the next query, select the **New** button from the toolbar. You will be prompted about saving the query. If you needed to save your query you would select **Yes** to bring up a **Save** dialog where you would save your query if desired. For this lesson, select **No** to clear the **Edit** pane.
Language Lesson

The SHOW/WHEN query allows a user to question what happens to the market when certain conditions are present. A query may be constructed by either making certain menu selections in the Query Builder window or by typing in the query directly into the Edit pane.

The format the SHOW/WHEN query language will appear in the Edit pane is as follows:

```
SHOW
1: (Column) of (Symbol)
WHEN
Defined Conditions are true
```

An attribute is a complete description of a time series. An attribute is any expression that, when interpreted, represents a series of values arranged chronologically into an array or matrix. An attribute is represented in Commodity Query by a unique identifier called a symbol. For example, cpq represents Compaq stock and us represents the U.S. 30-year Treasury Bond Futures contract. Symbols are organized in the database in hierarchical or tree fashion by certain major market categories.

Problem Solvers

1. Construct a query that will graph the closing price for the Crude Oil futures contract.

2. Construct a query that will graph the closing price for the Heating Oil futures contract.
CHAPTER 6

Limiting the Graph to a Relevant Period of Time

Synopsis

Objectives

1. Limiting the attributes using the WHEN date condition.
2. Using Multiple SHOW attributes.
4. Introduction to the arithmetic operator.

Market Brief

Investors examine price history for some significant period of time, such as a 52-week chart or a 6-month chart. Price history is commonly viewed in bar charts, although many chart traders may prefer to use only closing prices for their price graphs. A graph that uses a daily bar represents the opening price with a left horizontal mark, the close by a right horizontal mark and the two daily extremes of the high and low and as the top and bottom of a vertical line. The difference between the extreme points on the bar is the daily price range for the security. Some investors prefer to view the range as a value separate from the bar chart. Certain traders maintain that when a security trades within a tight range for a period of time (where the daily range is much smaller than usual for some period of time), a price breakout to the up or downside is expected.

To confine the period of time that the attribute will be shown, it is necessary to construct a WHEN condition. The WHEN condition provides the ability to confine the results of the query or “question about the markets” to specific dates and times of interest. Earlier it was mentioned that Commodity Query’s language structure for the SHOW/WHEN query, is SHOW my security WHEN certain conditions are met. What would you like to see WHEN those conditions are met? Show both a bar chart (the open, close, high and low prices for our security) and the daily range for your security.

Problem

For this lesson you will create an historical bar chart for the front continuous Natural Gas contract and the daily range for that contract for each day within the last year of trading. You will capture the daily price bar (open, high, low and
close) for all contracts that appear on the NYMEX as the nearest to expire and the range (the high of the day minus the low) for the same contract each day. Your query, when graphically executed, will display every closing price for the Natural Gas contract when the contract trades as the nearest to expire and the daily range for the contract. In order to construct this type of query it will be necessary to use the SHOW/WHEN query block. Using the SHOW/WHEN query, you will need to define a SHOW attribute and a compound SHOW attribute (constructed as SHOW attribute, Arithmetic Operator, SHOW attribute).

After you have completed the query, the following text will appear within the Edit pane of the Query Builder window.

```
SHOW
  1: Bar of NG
  2: High of NG - Low of NG
WHEN
  Date is within 1 year
```

Step-by-Step Solution

1. You need to create two separate SHOW attributes for this query. Begin by creating the first attribute, Bar of NG. Select the Search Database button then select the Tree View tab. Locate the symbol NG by opening the folders for Futures > Nymex. Right-click on the NG symbol and choose Select to add the symbol. Select OK to close the Search Database window and return to the Query Builder window.

2. Upon completion of the symbol, the Symbol field has NG highlighted and a description of the contract. Instead of using Close, you will select Bar from the Column pull-down menu.

3. Select the Add Attribute to Query button to add the attribute to the Edit pane. The Edit pane will contain the first SHOW attribute portion of the query.

4. The next SHOW attribute is actually a compound attribute: High of NG – Low of NG. This attribute will require selection from two attribute panes and the use of the Arithmetic Operator. Select NG as the symbol using the Search Database button or type NG into the Symbol field. Select High from the Column pull-down menu.

5. If you were to accept the information currently selected in the SHOW pane, you would simply see the high price for the Natural Gas futures contract. You want to see the difference, however, between the high and the low. In order to accomplish this task you will need to use an arithmetic operator to link the two attributes together (High of NG – Low of NG). To do this, select the Arithmetic Operator button and select the Radial button for Subtract.
6. The Arithmetic Operator portion of the window becomes ghosted and the SHOW portion of the window becomes active. In this SHOW window you will enter the Low of NG portion of your compound attribute. Enter NG into the Symbol field and choose Low as the Column to complete the attribute.

7. Select the Add Attribute to Query button in the SHOW pane of the Arithmetic Operator window to add the compound sentence High of NG – Low of NG to the Edit pane. The following shows the query so far.

SHOW
1: Bar of NG
2: High of NG - Low of NG

Refining the Pricing Graph in the WHEN Condition

1. The WHEN condition provides the ability to restrict the results of the query to specific dates or times of interest. For your pricing graph you want to restrict the time period, for which you will SHOW your attributes, to the last year.

2. In the WHEN pane of the Query Builder, select the Date Time Condition button. From the Date Time Condition window select the Date or Time button and select Date is from the items listed.

   The first four items listed are date condition selections, the next four are time condition selections.

3. Within 1 day will appear in the Date Time window and it will be necessary to change day to year in the pull-down menu in order to complete your date condition. If the Date Time Condition window has Date is within 1 year highlighted, select OK to complete the date condition.
4. Notice that the query in the Edit pane now contains the two SHOW attributes along with a WHEN condition. The WHEN condition limits the period of time that the SHOW attributes (the bar and daily range of the front Natural Gas contract) is displayed to the last year. Select the Graph button from the toolbar to graph the query.

5. To improve the clarity of the graph, you will use the graphic options to partition the attributes. Select the Options button at the bottom of the Graph window. There are several graphic options available to change to appearance of the graph.

For this lesson, you are limiting the first SHOW statement to the top quadrant of the graph (1: Bar of NG) and the second SHOW statement to the bottom quadrant of the graph (2: High of NG - Low of NG). Under the Attributes pane of the Graph Options window, select the 1 (label) button to bring up the 1 (label) window.

From the 1 (label) window, type 60 in the View (bottom) text field in the lower right-hand corner of the display. The View option may be used to limit the display of attributes to certain quadrants of the graph. If the 1 (label) window has 60 in the View (bottom) text field and 100 in the View (top) text field, select OK to return to the Graph Options window.

Next select the 2 (label) window, type 0 in the View (bottom) text field in the lower right-hand corner of the display. Change the View (top) setting to 40. Select OK to close the 2 (label) window and select OK to close the Graph Options window. The graph now is sectioned into two quadrants:
Language Lesson

You have now completed a basic price graph by specifying what attributes you want to show, when certain date conditions are met. The Execution Units (select Options > Execution Units from the menu bar) are set to check the condition (Date is 2005) on a daily basis. The attributes will be displayed for those days that meet the condition.

There may be several different attributes or “markets of interest” that a user could show in a query for certain defined conditions. Commodity Query automatically assigns a numerical label to each attribute, so as to avoid confusion when the answers to a query are displayed. For the example above, the first label appears as 1: and the second as 2. You may change the label by editing the query in the Edit pane to give the attribute a proper name such as Bar_NG. The assigned label can be anything you wish it to be as long as there are no spaces between the words used in the label.

Attributes may be represented by a single time series (e.g., the closing price of the Dow Jones Industrial Average or Close of DJIA in the Commodity Query language) or by multiples time series (e.g., The High of DJIA - Low of DJIA or the daily range of the Dow Jones Industrial Average). Attributes can be combined using simple arithmetic operations like addition and division, or complex functions such as correlation.

Conditions are added to a query by making selections from the Date Time Condition, Custom Event or Market Event buttons in the WHEN pane of the Query Builder window. In this lesson, you used the date condition date
is within 1 year. Notice some of the other selections available in the Date Time Condition window when the within choice is selected. You can select specific events such as is known date > election > Presidential Election Year.

Problem Solvers

1. Construct a query to graph the bar for the Crude Oil futures contract as well as the daily range for the last 2 years.

2. Construct a query to graph the bar for the Heating Oil futures contract as well as the daily range for the last 52 weeks.
Synopsis

Objectives

1. Introducing studies.
2. Introducing graphics options.
3. Reiterating date conditions.

Market Brief

Price graphs, like those used in the Wall Street Journal or other financial periodicals, are helpful aids used to determine where the current price of a security is in relationship to the prices the security traded at for some relevant past period of time. Researchers commonly employ the same technique to certain basic mathematical formulas. These formulas may be used to define trends based on changes within the formula’s value relative to some previous period. When studying the price trend of two or more related securities, it is sometimes helpful to employ a moving correlation study to better understand the change in price of a security relative to the other. A correlation study may be employed with the price series as an aid in determining price movement.

Problem

For this lesson you will display the index price for both the Florida Spot Gas and Henry Hub Spot Gas along with a one-month moving correlation study of both pricing series for the last two years.

The following shows how the query will appear after it is completed.

SHOW
Henry: Index of IGBBL21
Florida: Index of IGBAW21
Correlation: 1 month correlation of Index of IGBBL21 and Index of IGBAW21
When
Date is within 2 years

Step-by-Step Solution

Selecting the Attributes

1. This lesson requires a correlation study of two attributes along with the price history for those attributes. Let’s begin by creating the index price series for Henry Hub Spot Gas. To do this, use the Search Database button find the Henry Hub Gas Daily Price Survey in the Tree View. If the directory path is still pointing to NG, close the directory folders until you are at the topmost folder. Open the folders for Energy > NaturalGas > HenryHub > Platts then open the symbol IGBBL21 and double-click on Index to add the selections IGBBL21 and Index to the SHOW statement in the Query Builder. Select OK to close the Search Database window and then select the Add Attribute to Query button to add the SHOW statement to the Edit pane of the Query Builder.

2. You are going to use proper labels for our attributes so highlight the label 1: in the Edit pane and type the name Henry:

   SHOW
   Henry: Index of IGBBL21

3. Using the Search Database button, find the symbol IGBAW21 for Florida Gas by opening the folders: Energy > NaturalGas > FLGasTransmission > Platts then opening the symbol IGBAW21 and double-clicking on Index to add the selections IGBAW21 and Index to the SHOW statement in the Query Builder. Select OK to close the Search Database window then select the Add Attribute to Query button to add the SHOW statement to the Edit pane of the Query Builder.

4. You are going to use proper labels for your attributes so highlight the label 1: in the Edit pane and type the name Florida:

   SHOW
   Henry: Index of IGBBL21
   Florida: Index of IGBAW21

5. You will now create the one-month correlation study of Henry Hub and Florida Spot Gas. Commodity Query has over 100 different studies available to use with the data series. A study is a mathematical or statistical calculation of a data series. The result of the addition of a study to an existing defined symbol and column is the creation of a new data series. Examples of commonly used studies are: moving averages, highest high and lowest low calculations, correlation and co-regression.

   For your study you are going to use the correlation study. The first step is to enter the symbol IGBBL21 in the Symbol field and choose Index from the Column pull-down menu. To choose this study, select the Studies button in the SHOW statement pane of the Query Builder then choose correlation from the list and select OK.
The Study: Correlation window opens.

6. The attribute for Series1 is already populated with the IGBBL21 symbol and Index column (entered from the SHOW pane). To define the IGBAW21 attribute, select the Attribute button located next to next to Series2 and enter IGBAW21 for the Symbol and select Index for the Column then select OK to return to the Studies: correlation window. Lastly, define the period of time for the study by selecting the Time Period button. 1 day is the default period of time. Change Days to Months and select OK to return to the Studies: correlation window. Select OK to return back to the Query Builder window. Notice that the Studies button is highlighted. Select the Add Attribute to Query button to add the correlation study to the SHOW statement in the Edit pane.

7. You are going to use proper labels for your attributes so highlight the label 1: in the Edit pane and type the name Correlation. The following shows how the query should look:

SHOW
Henry: Index of IGBBL21
Florida: Index of IGBAW21
Correlation: 1 month correlation of Index of IGBBL21 and Index of IGBAW21

Refining the Price Graph in the WHEN Condition

1. In the WHEN pane of the Query Builder, select the Date Time Condition button then select the Date or Time button. You want to specify Date is and within 2 years. First select Date is from the pull-down menu. Keep the within selection then change 1 to 2 and Days to Years. If the Date Time Condition window has Date is within 2 years select OK to complete the date condition. The following shows the completed query:

SHOW
Henry: Index of IGBBL21
Florida: Index of IGBAW21
Correlation: 1 month correlation of Index of IGBBL21 and Index of IGBAW21
WHEN
Date is within 2 years

2. Select the Graph button from the toolbar to graph the query. Note that the study will return the statistical correlation coefficient between the two time series over a 1-month moving time window. This study returns values between the range of 1 (perfect correlation) and -1 (perfectly negative correlation).
3. To improve the clarity of the graph, you will use the Graphic Options to partition the attributes. Select the **Options** button at the bottom of the **Graph** window. There are several graphic options available to change to appearance of the graph.

For this lesson you are limiting the correlation study to the bottom quadrant of the graph. Under the **Attributes** pane of the **Graph Options** window, select **Default** to bring up the **Default Options** window that corresponds to the whole graph.

From the default window, type **25** in the **View (bottom)** text field in the lower right hand corner of the display. The **View** option may be used to limit the display of attributes to certain quadrants of the graph. If the default window has **25** in the **View (bottom)** text field and **100** in the **View (top)** text field, select **OK** to return to the **Graph Options** window.

4. Next, under the **Attributes** pane select **correlation** to bring up the correlation window that corresponds to the attribute labeled correlation. Type **20** in the **View (top)** text field. If the correlation window has **0** in the **View (bottom)** text field and **20** in the **View (top)** text field, select **OK** to return to the **Graph Options** window. Select **OK** to change the graphic options.

5. Commodity Query only has the capability to show two-reference axis at one time. If you are using multiple data series in the graphs, select on the data series of interest to change to reference axis. Each axis will retain the color of its respective data series.

The chart shows the final result of your query, displaying the correlation study in the bottom quadrant of the window.
Language Lesson

You have now completed a basic price graph with a technical study overlay by specifying a study of an attribute.

Studies are mathematical, statistical, and date functions that are compiled into the Commodity Query code for speed. The pull-down menu for the Studies button contains some of the more popularly used equations such as average, high and low. Server macros are similar to studies in that they provide calculations reduced down to a single statement in the query language. Unlike studies, however, server macros exist outside of the program code, and can be created, edited and modified by the user with a simple text editor. These server macro files are located in the `xmim/library/` directory within the `attr` and `column` sub-directories. Server macros tend to include more advanced technical indicators, statistical, and astrological calculations. For a detailed description of the studies and server macros, see the “Studies and Server Macros” chapter in the Commodity Query User Guide.

With regard to time expressions used within Commodity Query studies, there are two ways to specify the time period for a study. The default method is to specify a number (n) and a calendar measurement or some ‘time unit’ expression (i.e., Day, Month, Year or Quarter) in the Time Period window. For example, you can specify a time period such as:

- “10 day” (where 10 represents the number and day refers to time-unit); or
- “9 value” (where 9 represents the number specified and value is the time-unit that refers to actual values available in the data series); or
- “30 minute” (depending upon the Symbol used there may be intraday studies available); or
- “10 calendar year”.

The time unit menu is defaulted to Day but may be changed by pulling down the menu and selecting a different time unit. This default method will include all dates extending back from the current calculation date to some point back in time as in the expression. The other method of specifying the time period is to use the From-To buttons in the Time Period window. These buttons allow you to specify exactly the ending and starting points by making selections from the pull-down menu. The selections available for either button are: Today, Begin of Time/End of Time, Time Offset or Condition. Usually you will want the From date or the To date to be Today.

A small note is necessary here to describe how the studies react with the continuous futures contracts. For studies performed on a continuous-series futures contract, that involve a contract rollover (a period of time covering a rollover between an expiring contract and the next contract), the result is that the price gap that occurs between contracts on the rollover day is arithmetically removed from the series, so that the price discontinuity does not interfere with the results. In other words, the price of the futures contract today always represents the market price of the contract as it traded in the markets on that date. Prices on dates relative to today, forward or backward in time, if they are drawn from a contract other than the current (today) front or most actively traded contract, are adjusted, so that the gap that exists on the rollover date between the contracts is removed. To force the study to not adjust the futures continuous contract select the Execute Options button from the toolbar and check the box for Disable Back Adjustment in the Report Manipulation pane of the Execute Options window.
Problem Solvers

1. Create a 1-month correlation study of the front Natural Gas futures contract (NG) and the front Crude Oil contract for the last year.

2. Create a 2-week correlation study of the Henry Hub SpotGas, Index (IGBBL21) and Transco 45 (IGBU00) for the last 6 months.
CHAPTER 8

Basic Event-Driven Analysis using Date Conditions

Synopsis

Objectives

1. Introducing studies.
2. Using the time offset function.
3. Introducing the condition connector.
4. Using date files within the date condition.

Market Brief

Seasonality studies are commonly used as a research device to analyze price patterns surrounding certain time periods. For example, what happens to the price of the nearest to deliver natural gas contract during the high use winter season or what happens to stock prices during the month of January or at year end? Oftentimes, a researcher will employ a price graph to analyze price patterns surrounding certain significant dates. Commodity Query has the ability to supplement this technique by actually identifying certain significant dates through the use of the WHEN condition and analyzing the price movement for those dates using the SHOW attribute.

Problem

Isolate those periods of time within the last fifteen years when there was an OPEC meeting date and analyze the affect the meeting had on the price of the front Crude Oil futures contract by deriving the move of the closing price from the day of the meeting out over the next week. In the Commodity Query language what you want to SHOW is the 1-week move of the close of the Crude Oil futures contract WHEN the date is an OPEC meeting date falling within the last
fifteen years. After the query is completed, the following text will display within the Edit pane of the Query Builder window:

SHOW
  1: move from today to 1 week later of Close of CL
WHEN
  Date is within 15 years
  AND
  Date is in "Int'l_OPEC_Meet"

Step-by-Step Solution

Selecting the Study of an Attribute

1. The SHOW attribute used in this lesson involves a study of an attribute. From the SHOW pane select the Search Database button to find the Crude Oil futures contract under the Futures>Nymex folders; or, type the symbol CL into the Symbol field.

2. You will keep the default column Close for this example.

3. If you select OK at this point you would see the closing price of the front Crude Oil contract. However, what you want to do is to create a study on that price series. Select the Studies button from the SHOW statement portion of the Query Builder. From the Studies list select move.

Notice that you could substitute % move (which would return a ‘relative’ percent value instead of a dollar value; this study is particularly useful when analyzing the relative move of a security subject to inflationary pressure over an extended period of time).

4. Within the Study: move window, select the Time Period button. In the Time Period window select the radio button next to From. Today is a generic concept in Commodity Query and will take on the date that meets the WHEN condition. Keep the Today selection.

5. Next, you will want to change the To entry from the default setting of 1 Day Later to 1 Week Later. To accomplish this, select the To button and choose Time Offset from the pull-down menu. In the Time Offset window change Day to Week. If the Time Offset window has 1 Week Later highlighted, select OK to return to the Study: move window. The Study: move window should now have From: Today and To: 1 Week Later highlighted. If it does, select OK to return to the Query Builder.

6. The study of the attribute is now complete. Notice that the Studies button is highlighted. Select the Add Attribute to Query button to add the study information to the query in the Edit pane.

SHOW
  1: move from today to 1 week later of Close of CL
Refining the Price Analysis

WHEN (Condition)

If you were to execute the query with just the SHOW statement completed, the one-week move for the front Crude Oil contract would be displayed for all available dates within the database. However, you only want to see the week move that occurs following an OPEC meeting date for all meeting dates taking place within the last 15 years. In other words, you want to restrict results of our query to a specific set of market dates.

1. In the WHEN pane of the Query Builder, select the Date Time Condition button then select the Date or Time button.

2. You want to specify Date is within 15 years. In order to create this query statement select Date is from the list. Keep the within button selection and change 1 Day to 15 Years. The Date Time Condition window should have Date is within and 15 years highlighted.

3. Next, add another date condition by selecting the Add Condition button. There are two types of date criteria available: generic calendar dates that might be found on any calendar and special date events that are specific to the investment community. To add the date event condition: Date is in "Intl_OPEC_Meet" keep the AND logical operator then select the the Date or Time button and choose Date is from the list. Next, select the within button and choose in file>server file from the list. To locate the Intl_Opec_Meet date event select the Browse button and open the folder for Energy and choose Intl_Opec_Meet from the list. Select OK to close the Browse window. If the Date Time Condition window shows Date is in "Intl_Opec_Meet" then select OK to close the Date Time Condition window.

The Refresh Condition button will refresh the Date Time Condition window so that a new date or time condition can be constructed.

4. Your query is now complete:

    SHOW
    1: move from today to 1 week later of Close of CL
    WHEN
    Date is within 15 years
    AND
    Date is in "Intl_OPEC_Meet"

Graphing the query would give us a nonsensical chart; so, instead select Report from the toolbar to view the tabular results of the query. As mentioned earlier the left column represents the corresponding dates that meet your conditions and the furthest right column is the study of the data series or attribute. At the bottom of the report is statistical information about the entire population of the results. Note the percent of time you have seen a positive move up in prices versus that percent of time the contract sold off.

5. Select Dismiss to close the Report window.
6. The next two lessons will build upon this query so you will have to **Save** the language of this query before selecting **New** to work on the “Problem Solvers” section below.

### Language Lesson

In this lesson you reviewed a basic mode for event-driven analysis by creating a study of an attribute using the time offset feature. Additionally, you created a compound condition using the logical operator “AND” within your query.

There are two ways of specifying the time period for a study. The default method is to specify a number (n) and a calendar measurement or some “time unit” expression (i.e., Day, Month, Year or Quarter) in the **Time Period** window. For example, you can specify a time period such as 10 day (where 10 represents the number and day refers to time unit) or 9 value (where 9 represents the number specified and value is the time unit that refers to actual values available in the data series) or 30 minute (depending upon the symbol used there may be intraday studies available) or 10 calendar year.

The calculation window using the default method will include the dates extending back from the current calculation date to the point back in time specified in the time period expression. The other method of specifying the time period, which you used in the lesson above, is to use the **From-To** buttons located in the **Time Period** window. These buttons allow you to specify exactly the ending and starting points of the window by making selections from the pull-down menu. The selections available for either button are: Today, Begin of Time/End of Time, Time Offset or Condition. Usually you will want the **From** date or the **To** date to be **Today**. Remember that **Today** is a generic term in Commodity Query and will take on the date of the calculation.

### Problem Solvers

1. Create a study that analyzes the 1-week percent move of the front Natural Gas (NG) contract following all OPEC meeting dates falling after 1993.

2. Create a study that analyzes the 1-week move of the front Heating Oil (HO) contract leading up to all U.S. holidays.
CHAPTER9

Basic Event-Driven Analysis using Market Conditions

Synopsis

Objectives

1. Reiterating studies.
2. Limiting the attribute using the WHEN condition custom event.

Market Brief

In the previous lesson we mentioned that in reviewing a price graph it is possible to note certain changes in the price of securities associated with major market dates. What if, instead of focusing on a market date in the query, you described the price movement of the security as a condition that had to be met in order to SHOW our defined attribute. In other words what if you isolated those dates that made certain price movements and reviewed the price action of our security following the defined trend? This sort of analysis is done all the time in market industry periodicals. It is not uncommon for the Wall Street Journal or other newspaper to carry headlines that read “Stocks Plunge 300 points, Year's Worst Fall…Should We Expect a Rebound?”. It would be interesting to isolate those dates in the past when the market sold off by a similar amount to see what happened to the price of the securities.

Problem

Using the previous lesson, what would happen to the results of our query if the Crude Oil futures contract closed higher than it opened on the date of an OPEC meeting. Perhaps the market reacted positively to news released from the meeting, causing the contract to close higher. Does this positive reaction spill over into the week following the meeting or do you commonly see prices rebound?
In the Commodity Query language, you want to SHOW the move in the price of the futures contract WHEN the date is an OPEC meeting date within the last fifteen years and the close of the Crude Oil Contract is more than the open of the Crude Oil contract. After the query is completed, the following text should appear within the Edit pane of the Query Builder window:

SHOW
1: move from today to 1 week later of Close of CL
WHEN
  Date is within 15 years
  AND
  Date is in "Intl_OPEC_Meet"
  AND
  Close of CL is more than Open of CL

Step-by-Step Solution

Selecting an Additional Condition

1. You want to add another condition to the existing saved query used in the previous lesson. Open the saved query used in the last lesson.

2. Select the condition connector And then select the Custom Event button located in the WHEN area of the Query Builder to build the custom event condition.

3. There are two ways to build a custom event condition. Custom event conditions are often used to compare an attribute to another attribute or to compare the attribute to a constant or variable (normally a number representing price). A custom event condition may be built by completing either two panes of the Custom Event window (the left attribute and a conditional operator) or by completing three panes of the Custom Event window (the left attribute, a conditional operator and the right attribute). For this query, you will use all three panes of the Custom Event window: the close of the Crude Oil contract (the Left Attribute pane) is more than (Conditional Operator pane) the open of the Crude Oil contract (the Right Attribute pane).

4. In the Custom Event window, For the left attribute, select CL using the Search Database button or type in CL into the Symbol field. Keep the default column Close. Select the Continue button.

5. Remember that you need to fill out three panes. The next pane of the Custom Event window to complete is the Conditional Operator. You are comparing the closing price of our security with its price at the open by using the conditional operator. Select the radio button next to the conditional operator is exactly and change exactly to more than from the pull-down menu. Select the Continue button.

6. Now, complete the right attribute. Remember, the condition will be met if the Close of CL is more than the Open of CL. The first two panes completed so far are Close of CL is more than. To complete the sentence within the Right Attribute
pane, type in cl in the Symbol field then choose Open from the Column field. Select OK to close the Custom Event window and add the custom event to the query in the Edit pane.

7. The WHEN condition requires an OPEC meeting date within the last fifteen years where the price at the exchange for Crude Oil closes lower than the opening price that day. If all conditions are met then the one-week move in the price of the front Crude Oil contract, starting from the date that all three conditions will display.

Select the Report button in the toolbar to produce the report. Notice the difference in statistics of our results from the previous lesson. By including an additional market condition you have decreased the number of results but also you have changed the number of positive results.

When creating queries, add the conditions one at a time to see what effect each additional condition has on the answer population.

Language Lesson

In this lesson you reviewed the effect of including a market condition using a custom event on the population of your results.

There are many places in the Commodity Query language where attributes can be selected for use. A left or right attribute pane indicates that you can build an attribute expression in the query syntax at that point. The SHOW part of a SHOW / WHEN query is a typical place to use an attribute expression. Often, you are trying to produce results based upon certain conditions or patterns in the market. In order to do this, it is necessary to reference or compare the attribute to some other attribute or constant by creating a WHEN condition. Stated another way, users often want to SHOW an attribute WHEN the attribute has reacted in some specified pattern.

The custom event condition's general format is as follows:

<Left Attribute> <Conditional Operator> <Right Attribute>

The format is rather simple to understand: some specified attribute, (left attribute) does something in comparison to, i.e., is more than (conditional operator) some other specified attribute, (right attribute). For convenience, the Conditional Operator pane of the Custom Event window contains some terminal selections that are shortcuts taking away the need to specify a right attribute. Thus, in some instances it is possible to form a complete condition using just the <Left Attribute> and the <Conditional Operator>. Whenever you finish an pane in the Custom Event window by selecting Continue the next pane becomes active in natural sequence to finish the menu construction of the condition.

Most of the functions available in the Conditional Operator window are pretty self-explanatory. However, the function is defined or is not defined located in the second line bears review. Both of these conditional operator options allow you to test whether a value exists for a specified attribute. An attribute is not defined whenever the results of execution of the query would be NaN (not a number), i.e., if there is no value in the database for the specified attribute. A few of the data series in the database may be missing data because of the nature of the series (i.e., the data available in the market is scarce or not provided by many data suppliers.) As a matter of preference, you
may choose to disregard certain series that are missing data. The easiest way to identify missing data is to use the is not defined function.

Problem Solvers

1. Create a study that analyzes the 1-week move of the front Natural Gas (NG) contract following all OPEC meeting dates falling after 1993 whenever the close price for the contract is more than the open on the date of the meeting.

2. Create a study that analyzes the 1-week move of the front Heating Oil (HO) contract following all OPEC meeting dates falling after 1993 whenever the close price for the contract is more than the open on the date of the meeting.
SYNOPSIS

Objective

1. Using the WHEN condition repeat function.
2. Reiterating the use of multiple conditions.
3. Introducing geophysical data.
4. Introducing execute options.

Market Brief

There are two basic schools of market analysis: technical analysis and fundamental analysis. Most of the research tools discussed in the earlier chapters are commonly associated with technical analysis. Given the wealth of Morningstar Commodity Data data available, several types of fundamental analysis can also be generated.

There is a wealth of data series available to an energy market participant (such as weather data or sentiment data) that can be used to develop interesting research. For example, heavy buying of energy products by large utility companies could be the direct result of unforeseen consumer demand caused by a change in weather.

Problem

You will analyze the effect of a first and fourth quarter Chicago cold snap on the price of the index price of spot natural gas for Henry Hub.
In the Commodity Query language, you want to SHOW the 4-value move of the spot price of Henry Hub natural gas WHEN the date is any 1st or 4th quarter following 1990 and where the low temperature for that date, as sampled at the O’Hare airport in Chicago, is down more than 15% from the previous day’s low. Additionally, this weather pattern has been repeated for the previous 2 days and current day. After the query is completed, the following text will appear within the Edit pane of the Query Builder window:

SHOW
1: move from today to 4 values later of Index of IGBBL21
WHEN
  Date is after 1990
  AND
  LowTemp of CHICAGO.OHARE.IL is down more than 15 % repeated for the previous 2 and current day
  AND
  {  
    Date is fourth quarter
    OR
    Date is first quarter
  }

Step-by-Step Solution

Select the Study of the Attribute

1. You want to take a look at the four-value move of the Index of Henry Hub. Commodity Query conveniently substitutes shorter frequencies of time for periods missing within the database. For example, if the query asks for a 4-day average and only 3 days are available for the study, Commodity Query will return a 3-day average. The term "value" represents actually values in the database and is sometimes substituted for ‘day’ or other frequencies to ensure that the studies calculate the specified number of values and don’t substitute a shorter frequency for periods missing within the database. For example, on a non-trading holiday Commodity Query will return a result for a study that requires n day average because of the substitution feature in the software; however, the use of n value average will return “NaN”.

2. In the SHOW pane of the Query Builder window type IGBBL21 into the Symbol field and select Index from the Column pull-down menu.

3. Select the Studies button and select Move from the list. In the Study: move window select the Time Period button then select the radio button for the FROM/TO selection. In the From pull-down select Today. In the To pull-down, select Time Offset. In the Time Offset window, change 1 to 4. From the next pull-down change Day to Value and from the next pull-down, change Ago to Later. Select OK to close the Time Offset window and OK to close the Time Period window. Select OK to close the Study: move window and then select the Add Attribute to Query button to add the statement to the Edit pane of the Query Builder window.

The following shows the query statement so far:
Creating a Market Condition Using Weather Data

1. A time saving technique that becomes more important with more involved or complex queries is the ordering of the conditions. For this lesson, you have three date conditions (Date is after 1990, Date is fourth quarter and Date is first quarter) and one custom event condition (LowTemp of CHICAGO.OHARE.IL is down more than 15%). The custom event condition is repeated over several periods so the repeat function will be used in the query (repeated for the previous 2 and current day). Commodity Query will check each condition in sequential order. If a condition effectively reduces the number of dates to check for each subsequent condition, our query will execute all that much faster. The condition that eliminates the most dates for this lesson is Date is after 1990 so this will be the first condition you create.

2. In the WHEN pane of the Query Builder window, select the Date Time Condition button then select the Date or Time button. Next, select Date is after from the list. Select the within button and choose in Year from the pull-down menu. Enter 1990 for the year. The Date Time Condition window should have Date is after in 1990 entered. Select OK to add the statement to the Edit pane and return to the Query Builder window.

3. Select the logical operator AND from the list in the WHEN pane of the Query Builder window.

4. The custom event condition used in this lesson is a condition that makes a comparison of an attribute (in our case the weather Low in Chicago). In the WHEN pane of the Query Builder window, select the Custom Event button. For the Left Attribute pane in the Custom Event window you need to look up your weather site, the O'Hare airport in Chicago, Illinois. Select the Search Database button and then select the Tree View tab. Within the Tree View window, open the folders for: Weather>Geophysical>Geo_N.Amer>Geo_USA.East> Geo_Illinois. Make the final symbol selection of CHICAGO.OHARE.IL by right-clicking on the symbol and choosing Select. Select OK to exit the Search Database window. For the Column field, choose LowTemp from the pull-down menu.
5. Select the **Continue** button to enter the conditional operator.

6. From the **Conditional Operator** pane of the **Custom Event** window select the radio button for **is up exactly** then change **is up** to **is down** and **exactly** to **more than** from the pull-down menus. In the Percentage field type 15.
The following shows the completed Conditional Operator pane:

Select the OK button to add the entries to the query in the Edit pane and return to the Query Builder window.

7. Use the repeat function to repeat the weather condition for the previous 2 days and current day. In the WHEN pane of the Query Builder window, select the Repeat button. The Repeat window should have two columns. You will ignore the left-most column and focus on making changes to the Repeat Period column on the right. You want the weather condition to be repeated for the previous 2 days and current day so you will have to uncheck Next. You need to change the number from 1 to 2 in the text field next to Previous. If the Repeat Period pane of the Repeat window has Previous, Current and Day highlighted select OK.
The following shows the **Repeat** window entries:

![Repeat Window](image)

Select **OK** to add the repeat statement to the **Edit** pane of the **Query Builder** window. The following shows how the query should look so far:

```
SHOW
1: move from today to 4 values later of Index of IGBBL21
WHEN
    Date is after 1990
    AND
    LowTemp of CHICAGO.OHARE.IL is down more than 15 %
repeated for the previous 2 and current day
```

8. Next, add the two date conditions. Select the **Date Time Condition** button then select **Date or Time**, select **Date is** then select the within button and choose **in quarter** and **fourth quarter** from the pull-down menu. If the **Date Time Condition** window has **Date is Fourth Quarter** listed, select **OK** to return to add the statement to the **Edit** pane and return to the **Query Builder**.

9. In the **WHEN** pane of the **Query Builder** select **OR** as the Condition Connector.

10. Select the **Date Time Condition** button then select **Date or Time** and select **Date is** then select the **within** button and choose **in quarter** then choose **first quarter** from the list. Select **OK** to add the statement to the **Edit** pane and return to the **Query Builder**.

11. The two date conditions (**Date is fourth quarter** and **Date is first quarter**) are obviously mutually exclusive. You will use braces to denote that one or the other of these conditions must be met along with the first two aforementioned conditions in order to SHOW your attribute. In the **Edit** pane add the curly braces to the query so that the query matches the following:

```
SHOW
1: move from today to 4 values later of Index of IGBBL21
WHEN
    Date is after 1990
    AND
    LowTemp of CHICAGO.OHARE.IL is down more than 15 %
repeated for the previous 2 and current day
```
AND
{
  Date is fourth quarter
  OR
  Date is first quarter
}

12. Execute the query by selecting the Report button from the toolbar. (The following shows a portion of the report.)

<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/22/1991</td>
<td>Tue</td>
<td>-0.0200</td>
</tr>
<tr>
<td>02/16/1991</td>
<td>Sat</td>
<td>0.0000</td>
</tr>
<tr>
<td>03/29/1991</td>
<td>Fri</td>
<td>-0.0200</td>
</tr>
<tr>
<td>11/03/1991</td>
<td>Sun</td>
<td>0.0000</td>
</tr>
<tr>
<td>11/04/1991</td>
<td>Mon</td>
<td>0.1200</td>
</tr>
<tr>
<td>11/25/1991</td>
<td>Mon</td>
<td>0.0000</td>
</tr>
<tr>
<td>11/26/1991</td>
<td>Tue</td>
<td>0.0800</td>
</tr>
<tr>
<td>12/15/1991</td>
<td>Sun</td>
<td>-0.0800</td>
</tr>
<tr>
<td>01/15/1992</td>
<td>Wed</td>
<td>0.0200</td>
</tr>
<tr>
<td>01/16/1992</td>
<td>Thu</td>
<td>0.0200</td>
</tr>
<tr>
<td>02/09/1992</td>
<td>Sun</td>
<td>0.0000</td>
</tr>
<tr>
<td>03/11/1992</td>
<td>Wed</td>
<td>0.0800</td>
</tr>
<tr>
<td>11/13/1992</td>
<td>Fri</td>
<td>0.0000</td>
</tr>
<tr>
<td>11/14/1992</td>
<td>Sat</td>
<td>0.0000</td>
</tr>
<tr>
<td>12/05/1992</td>
<td>Sat</td>
<td>0.0000</td>
</tr>
<tr>
<td>01/15/1993</td>
<td>Fri</td>
<td>0.0000</td>
</tr>
<tr>
<td>02/24/1993</td>
<td>Wed</td>
<td>0.3050</td>
</tr>
<tr>
<td>03/12/1993</td>
<td>Fri</td>
<td>0.3200</td>
</tr>
<tr>
<td>11/07/1993</td>
<td>Sun</td>
<td>-0.0500</td>
</tr>
<tr>
<td>12/24/1993</td>
<td>Fri</td>
<td>0.0200</td>
</tr>
<tr>
<td>12/25/1993</td>
<td>Sat</td>
<td>-0.0200</td>
</tr>
<tr>
<td>01/09/1994</td>
<td>Sun</td>
<td>0.0900</td>
</tr>
<tr>
<td>01/14/1994</td>
<td>Fri</td>
<td>0.0600</td>
</tr>
<tr>
<td>01/15/1994</td>
<td>Sat</td>
<td>0.5900</td>
</tr>
<tr>
<td>01/31/1994</td>
<td>Mon</td>
<td>0.8000</td>
</tr>
</tbody>
</table>

13. Notice that there are several consecutive days listed on the left-most column of the Commodity Query report. If you were to actually take a position based on these conditions, it might be safe to say that you would react to the first day that meets the conditions or the first adjacent value. Commodity Query allows you the ability to look at the first adjacent days by changing the default Execute Options settings. Select Options > Execute Options from the menu bar then select the Report tab. Under the Report Manipulation pane change Display: All Adjacent Values to Display: First Adjacent Value and select OK.

14. Select the Report button from the toolbar to re-execute the query. Notice that the number of occurrences dramatically decline because of the changed default settings. (The following shows a portion of the report.)

<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/22/1991</td>
<td>Tue</td>
<td>-0.0200</td>
</tr>
<tr>
<td>02/16/1991</td>
<td>Sat</td>
<td>0.0000</td>
</tr>
<tr>
<td>03/29/1991</td>
<td>Fri</td>
<td>-0.0200</td>
</tr>
<tr>
<td>11/03/1991</td>
<td>Sun</td>
<td>0.0000</td>
</tr>
<tr>
<td>11/04/1991</td>
<td>Mon</td>
<td>0.1200</td>
</tr>
<tr>
<td>11/25/1991</td>
<td>Mon</td>
<td>0.0000</td>
</tr>
<tr>
<td>11/26/1991</td>
<td>Tue</td>
<td>0.0800</td>
</tr>
<tr>
<td>12/15/1991</td>
<td>Sun</td>
<td>-0.0800</td>
</tr>
<tr>
<td>01/15/1992</td>
<td>Wed</td>
<td>0.0200</td>
</tr>
<tr>
<td>01/16/1992</td>
<td>Thu</td>
<td>0.0200</td>
</tr>
<tr>
<td>02/09/1992</td>
<td>Sun</td>
<td>0.0000</td>
</tr>
<tr>
<td>03/11/1992</td>
<td>Wed</td>
<td>0.0800</td>
</tr>
<tr>
<td>11/13/1992</td>
<td>Fri</td>
<td>0.0000</td>
</tr>
</tbody>
</table>
Language Lesson

An important calculation subtlety of Commodity Query is that a specified time period may include holidays or missing data thereby effectively reducing the actual number of data points used in a study. For example, a 15-day moving average that spans both Christmas and New Year’s Day will be calculated based on only 13 price samples. Many users prefer to calculate studies based on the last “n values” (this is the last actual n data points irrespective of holidays or missing data) instead of the last “n time” (e.g., day) periods. You can accomplish this in the Commodity Query language: specify, instead of “days” as the time period, the keyword “values” and the study will be calculated using the specified number of values from the data series. This concept is particularly important where the study is a triggering condition for the ORDER query (back testing trading ideas using an ORDER query will be discussed in Chapter 15, “Back-Testing Long & Short Moving Average Trading Strategies”). If a date is a holiday, such as New Years Day, Commodity Query will return data on a non-trading day because of the calculation subtlety discussed. Because it is impossible to ‘place’ a trade on a holiday this trading signal will be ignored. This issue will be discussed in detail in the chapter dealing with ORDER queries.

Problem Solvers

1. For any date in December, January or February following 1990 where the low temperature at the New York LaGuardia Airport, is down over 20% for two days in a row, show the move from this date (today) to 3 days later of the front Natural Gas contract (NG)
Event-Driven Analysis on Multiple Symbols

Synopsis

Objectives

1. Using a \texttt{LET} statement with multiple symbols.
2. Using the \texttt{How Do I Say} feature.

Market Brief

Often a query that provides useful insight regarding the historical patterns of one symbol can be applied to multiple symbols. In previous lessons the problems focused the analysis on one symbol and how that one symbol reacted to certain conditions, but with the Commodity Query \texttt{LET} statement it is possible to run that same query on a list of symbols all at once.

Problem

You will take a look at what's happened in the past to NYMEX Crude Oil, NYMEX Natural Gas, and ICE Brent Crude futures when the future is up 9 days in a row. You will study the percent move from the event date to 1, 2, and 3 days later. Using the \texttt{LET} feature you will set a variable to equal your list of futures so that when you run the query, you will get separate results for each future. You will also use the \texttt{How Do I Say} feature to provide syntax assistance with your event condition that the future is up 9 days in a row.

After the query is completed, the following text will appear within the \texttt{Edit} pane of the \texttt{Query Builder} window:

\begin{verbatim}
LET @MyList = CL, NG, FB
SHOW 1: percent_move from today to 1 day later of @MyList
\end{verbatim}
2: percent move from today to 2 days later of @MyList
3: percent move from today to 3 days later of @MyList
WHEN
@MyList is up
repeated for the previous 8 and current value

Step-by-Step Solution

1. Select the LET button from the toolbar to open the LET window. In the Series Variable pane keep the entry @MyList for the variable name and type CL into the next field for the symbol name. Select the Enter button to add the symbol name CL to the Specified Series pane.

The variable names shown are just suggestions. Variable names are user-defined but should be in mixed case or start with an @ sign so that there is not a possibility of duplicating a symbol name. Also, no spaces are allowed.
2. Next, type the symbol name NG into the symbol field and select the Enter button to add NG to the Specified Series pane.

You may use the Remove Item button to remove a symbol name from the Specified Series pane, if needed.

3. Next, type the symbol name FB into the symbol field and select the Enter button to add FB to the Specified Series pane. Select the OK button to close the LET window. The following displays in the Edit pane:

```
LET @MyList = CL, NG, FB
```

4. In the SHOW pane select the button and change the selection from Symbol to Variable. In the Variable field type in the name @MyList. Select the Studies button and choose % move from the list.

5. In the Study: % move window, select the Time Period button and select the radial next to From Today To 1 Days Later. Select the OK button to close the Time Period window then select the OK button to close the Study: % move window.

Notice that the Studies button is highlighted to show that an entry was made.

6. In the SHOW pane select the Add Attribute to Query button. The following shows the entries so far in the Edit pane.

```
LET @MyList = CL, NG, FB
SHOW 1: percent_move from today to 1 day later of @MyList
```

7. Next, in the SHOW pane select the button and change the selection from Symbol to Variable. In the Variable field type in the name @MyList. Select the Studies button and choose % move from the list.

8. In the Study: % move window, select the Time Period button and select the radial next to From Today To 1 Days Later. Select the To button and choose Time Offset from the list. In the Time Offset window change 1 Day Later to 2 Day Later. Select the OK button in each window to return to the Query Builder window.

Notice that the Studies button is highlighted to show that an entry was made.

9. In the SHOW pane select the Add Attribute to Query button. The following shows the entries so far in the Edit pane.

```
LET @MyList = CL, NG, FB
SHOW
```
Chapter 11: Event-Driven Analysis on Multiple Symbols

1. percent_move from today to 1 day later of @MyList
2. percent_move from today to 2 days later of @MyList

10. Next, in the **SHOW** pane select the 👤 button and change the selection from **Symbol** to **Variable**. In the **Variable** field type in the name @MyList. Select the Studies 🔄 button and choose % move from the list.

11. In the **Study: % move** window, select the Time Period button and select the radial next to **From Today To 1 Days Later**. Select the To button and choose Time Offset from the list. In the **Time Offset** window change 1 Day Later to 3 Day Later. Select the OK button in each window to return to the Query Builder window.

Notice that the Studies 🔄 button is highlighted to show that an entry was made.

12. In the **SHOW** pane select the Add Attribute to Query ✖️ button. The following shows the entries so far in the Edit pane.

   ```
   LET @MyList = CL, NG, FB
   SHOW
   1: percent_move from today to 1 day later of @MyList
   2: percent_move from today to 2 days later of @MyList
   3: percent_move from today to 3 days later of @MyList
   ```

13. Select the How Do I Say 📁 button from the toolbar. In the **How Do I Say** pane select IBM is Up 5 times in a row. Select the Customize button and in the Customize pane change 5 to 9 so that the statement is IBM is up 9 times in a row. Select the Add to My Query button. The following shows the query in the Edit pane:

   ```
   LET @MyList = CL, NG, FB
   SHOW
   1: percent_move from today to 1 day later of @MyList
   2: percent_move from today to 2 days later of @MyList
   3: percent_move from today to 3 days later of @MyList
   WHEN IBM is up repeated for the previous 8 and current value
   ```

14. In the WHEN condition replace IBM with @MyList by editing the query in the Edit pane. The following shows the finished query:

   ```
   LET @MyList = CL, NG, FB
   SHOW
   1: percent_move from today to 1 day later of @MyList
   2: percent_move from today to 2 days later of @MyList
   3: percent_move from today to 3 days later of @MyList
   WHEN @MyList is up repeated for the previous 8 and current value
   ```

15. Select the Report 📈 button from the toolbar to generate the answers. Notice how the report shows three separate results for each of the futures. The following shows a partial listing for each symbol in the report:
Let variable values:
@MyList=CL

<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/27/1985</td>
<td>Fri</td>
<td>0.5185</td>
<td>0.3457</td>
<td>1.1407</td>
</tr>
<tr>
<td>09/30/1985</td>
<td>Mon</td>
<td>-0.1719</td>
<td>0.6190</td>
<td>0.7909</td>
</tr>
<tr>
<td>02/16/1996</td>
<td>Fri</td>
<td>0.0000</td>
<td>9.8643</td>
<td>12.1607</td>
</tr>
<tr>
<td>08/20/2002</td>
<td>Tue</td>
<td>1.5609</td>
<td>0.2325</td>
<td>-0.4650</td>
</tr>
<tr>
<td>08/21/2002</td>
<td>Wed</td>
<td>-1.3680</td>
<td>-2.0862</td>
<td>0.1368</td>
</tr>
<tr>
<td>09/28/2004</td>
<td>Tue</td>
<td>-0.7816</td>
<td>-0.5210</td>
<td>0.4409</td>
</tr>
</tbody>
</table>

Let variable values:
@MyList=NG

<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/24/1992</td>
<td>Tue</td>
<td>6.9111</td>
<td>2.8914</td>
<td>3.1735</td>
</tr>
<tr>
<td>11/26/1996</td>
<td>Tue</td>
<td>-2.3457</td>
<td>-2.3457</td>
<td>NaN</td>
</tr>
<tr>
<td>05/18/2000</td>
<td>Thu</td>
<td>3.0997</td>
<td>0.9973</td>
<td>2.8032</td>
</tr>
<tr>
<td>05/19/2000</td>
<td>Fri</td>
<td>-2.0392</td>
<td>-0.2876</td>
<td>6.4837</td>
</tr>
<tr>
<td>08/11/2000</td>
<td>Fri</td>
<td>-3.5084</td>
<td>-5.3855</td>
<td>-1.3855</td>
</tr>
</tbody>
</table>

Let variable values:
@MyList=FB

<table>
<thead>
<tr>
<th>Date</th>
<th>Day</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/23/2004</td>
<td>Thu</td>
<td>0.4432</td>
<td>1.7727</td>
<td>2.9249</td>
</tr>
<tr>
<td>09/24/2004</td>
<td>Fri</td>
<td>1.3236</td>
<td>2.4708</td>
<td>1.6545</td>
</tr>
<tr>
<td>09/27/2004</td>
<td>Mon</td>
<td>1.1322</td>
<td>0.3266</td>
<td>0.9798</td>
</tr>
<tr>
<td>09/28/2004</td>
<td>Tue</td>
<td>-0.7966</td>
<td>-0.1507</td>
<td>0.3660</td>
</tr>
<tr>
<td>04/02/2007</td>
<td>Mon</td>
<td>-1.3529</td>
<td>-0.4946</td>
<td>-0.7274</td>
</tr>
<tr>
<td>09/12/2007</td>
<td>Wed</td>
<td>-0.3605</td>
<td>-1.5191</td>
<td>-0.5407</td>
</tr>
</tbody>
</table>

16. Dismiss the report and select the New button to clear the Edit pane for the next lesson.

Language Lesson

The LET statement is useful for a variety of tasks. Not only can you set a variable to your own list of symbols as you did in this lesson but you can set a variable to a file that contains symbols or a parent category in the database hierarchy. For instance, if you want to run a query on all of the futures on the NYMEX you can use the browser in the LET window to navigate to TopRelation:Futures:Nymex and select Nymex to run the query on all the children symbols under this category. The resulting LET statement would look as follows:

LET
@MyGroup = TopRelation:Futures:Nymex

Inserting the syntax “CONTINUOUS” in front of TopRelation in the example above would iterate through the continuous contracts only. Inserting “CONTRACTS” in front of TopRelation in the example above would iterate through the individual contracts only.
Problem Solvers

Create a query that looks at what happens in terms of percent move 1, 2, and 3 days later to the Natural Gas and Heating Oil Futures when the Winter in Chicago is colder than expected.
CHAPTER 12

Analysis using Intraday Data

Synopsis

Objectives

1. Introducing execution units.
2. Introducing IF-THEN-ELSE statements.
3. Using studies on intraday data.

Market Brief

In the previous lessons you looked at the change of price in our security over some period of time. It might be interesting to look at the prices during the day to research when specific events occurred. The intraday data is provided in pricing bars. Price bars are a representation of the price at the open of a period, the close of that period and the high and low reached during the period. Commodity Query allows you to look at price bars for any period of time down to millisecond bars where intraday data exists for a series.

Problem

For this lesson you will construct a query that uses the intraday data to indicate the exact minute the high occurred for the continuous CL future contract for the most recent trading date. In the previous lessons, the conditions were checked on a daily basis throughout the history of the database (i.e., does 1/1/90 meet our condition?; does 1/2/90 meet our condition?; 1/3/90? 1/4/90?; etc…) and the attribute displays for each day meeting the specified conditions (i.e., display the daily Closing Price for 1/1/90, display the daily Closing Price for 1/2/90, etc…).

The common time period to check the WHEN conditions and display the SHOW attribute was daily. In the Commodity Query language, the execution units (or global time units) were set for the previous lesson to the default or “1 day” setting. In this exercise, a query is being used to look closer at the data and research more about the intraday data on
You will modify the execution units to 1 minute in order to access the intraday values. Also, an IF-THEN-ELSE statement will be used in the SHOW to mark where the high for the day occurred.

After the query is completed, the following text will appear within the Edit pane of the Query Builder window:

```
SHOW
MinuteHigh: High of CL
Highest: highest from 10:00 am to 02:30 pm of High of CL
Indicator: IF
  High of CL is exactly highest from 10:00 am to 02:30 pm of
  High of CL
  THEN 1
ENDIF
WHEN
  Date is within 1 day
```

### Step-by-Step Solution

1. To begin, set the execution units to 1 minute. From the toolbar, select the Execution Units button. Change 1 Day to 1 Minute. Select OK to close the Execution Units window.

2. The next step towards making the query is to create the SHOW statement High of CL. In the Symbol field type in CL (for the NYMEX: Light, Sweet Crude Oil Futures contract). For the Column, choose High from the pull-down menu. Select OK to add the SHOW statement to the Edit pane of the Query Builder window. Change the label in the Edit pane from 1: to MinuteHigh:

3. To create the next line in the SHOW statement enter CL in the Symbol field and for the Column, choose High from the pull-down menu. Select the Studies button from the SHOW pane then select highest from the list. The Study: highest window opens. Select the Time Period button then select the radio button for From-To. Select the From button and from the pull-down menu select Condition > Date Time Condition. In the Date Time Condition window select the Date or Time button then select Time is from the pull-down menu. Keep exactly and enter the time 10:00 and select am. If the statement shows Time is exactly 10:00 am select OK to close the window and return to the Time Period window for the study.

4. Next, select the To button and from the pull-down menu select Condition > Date Time Condition. In the Date Time Condition window select the Date or Time button then select Time is from the pull-down menu. Keep exactly and enter the time 2:30 and select pm. If the statement shows Time is exactly 2:30 pm select OK to close the Date Time window and return to the Time Period window for the study. Select OK to close the Time Period window.

5. Select OK to close the Study: highest window and return to the Query Builder window. Select the Add Attribute to Query button to add the query statement to the Edit pane.

6. In the Edit pane of the Query Builder window, change the label 1: to Highest:. The following shows the query progress:

```
SHOW
MinuteHigh: High of CL
```
Chapter 12: Analysis using Intraday Data

7. This step will show how to make an IF-THEN statement. In the SHOW pane of the Query Builder window enter CL in the Symbol field and choose High for the Column.

In the SHOW pane, select the IF-THEN-ELSE button. In the IF portion of the IF-THEN-ELSE window select the Condition button and choose Custom Event from the pull-down menu. In the Custom Event window enter CL in the Symbol field and choose High from the Column pull-down menu. Select the Continue button.

In the Conditional Operator pane select the radial button for is exactly then select the Continue button.

In the Right Attribute pane type CL in the Symbol field and choose High from the Column pull-down menu. Select the Studies button and choose highest from the list. Select the OK button. In the Studies:highest window select the Time Period button and select the radial button next to From To.

Select the From button and choose Condition > Date Time Condition. Select the Date or Time button and choose Time is from the list. Keep exactly and change the time setting to 10:00 am then select the OK button.

Next, select the To button and choose Condition > Date Time Condition. Select the Date or Time button and choose Time is from the list. Keep exactly and change the time setting to 2:30 pm then select the OK button. Close the Time Period window by selecting OK. Close the Studies:highest window by selecting OK. Notice that the Studies button is now highlighted. Select OK to close the Custom Event window.

Next, in the THEN portion of the IF-THEN-ELSE window select the THEN Attribute button. Select the Variable button and choose Constant from the list. Type 1 in the Constant field and select OK. Select OK to close the IF-THEN-ELSE window and return to the Query Builder window. Notice that the IF-THEN-ELSE button is highlighted to show that it contains entries. Select the Add Attribute to Query button to add the IF-THEN-ELSE statement to the query in the Edit pane.

8. The last step is to set the WHEN date condition for the query. From the WHEN pane select the Date Time Condition button then select the Date or Time button and choose Date is from the list. Change exactly to within and make sure 1 Day is selected. If the Date Time Condition window shows Date is within 1 Day select the OK button to close the window and add the date condition to the query in the Edit pane. The final query is as follows:

SHOW
  MinuteHigh: High of CL
  Highest: highest from 10:00 am to 02:30 pm of High of CL
  Indicator: IF
    High of CL is exactly highest from 10:00 am to 02:30 pm of
    High of CL
    THEN 1
    ENDIF
WHEN
  Date is within 1 day

9. Select the Report button to generate the answers for the query. Notice below that the 1.000 in the Indicator column shows when the exact time the high of the day was made. (The following is a portion of the report results.)
10. Dismiss the report and select the **New** button to clear the **Edit** pane for the next lesson.

Language Lesson

This lesson examined the intraday minutely data. Commodity Query has a setting called execution units which determines the time-frequency over which queries will range through the database looking for answers. As mentioned, the default frequency is daily but may be changed to any frequency from one minute to any number of years. The execution units are set using the **Options > Execution Units** menu bar selection (or select the **Execution Units** button from the toolbar).

Depending on availability of data (most securities in the database have daily prices but not all of these securities have intraday prices available), it is possible to create different time frequencies for the symbol (i.e., daily, weekly or monthly pricing bars). If intraday data exists for a series, it is possible to display frequencies of minutes, hours, days, week, months, quarters and years. Where no intraday data is available for a series, only frequencies greater than intraday may be used for the query (i.e., daily, monthly, quarterly or yearly). The default time mechanism in Commodity Query is set to daily; however, a user may save their desired execution unit as the user default.

We also introduced how the IF-THEN-ELSE statement can be used to indicate when the high was made during the day. The general formula for an IF-THEN-ELSE statement is

\[
\text{IF} \quad \text{condition is true} \quad \text{THEN} \quad x \quad \text{ELSE} \quad y
\]

For the Commodity Query specifically, this can be translated to

\[
\text{IF} \quad \text{condition} \quad \text{THEN} \quad \text{Attribute A} \quad \text{ELSE} \quad \text{Attribute B}
\]

This query did not specify an ELSE statement as it is not necessary for every IF-THEN-ELSE statement. We used the “THEN 1” as a visual indicator of the high of the day and if we had included ELSE 0 in our statement the 1 would not be as easy to spot. By leaving off the ELSE statement, a Nan is returned if the condition is not true, making a “1” easier to see.

IF-THEN-ELSE statements can also be used to chain two histories together. For instance if one time series stops and another one starts, these can be linked together with the following syntax.

\[
\text{IF Column of SYMBOLA is defined THEN Column of SYMBOLA ELSE Column of SYMBOLB}
\]

Another use of IF-THEN-ELSE statements is to show a value when a condition has occurred. For instance if you want to show the settlement price of a future contract on its expiration day, the following syntax could be used.

\[
\text{IF Date is CL expiration day THEN Close of CL}
\]

Problem Solvers

Construct a query that uses the intraday data to indicate the exact minute the low occurred for the continuous Crude Oil Future contract for the most recent trading date.
CHAPTER 13

Event-Driven Analysis using Intraday Data

Synopsis

Objectives

1. Introducing time offset.
2. Introducing attribute units.
3. Using time conditions.

Market Brief

When a stock or other trading instrument has a higher open price than the price that it closed at on the previous day this is referred to as a gap. This can be a considerable move up or down in price with no trades occurring between the official close and open of the market. Market events such as important meeting dates, economic report releases, or earnings announcements, can cause these gaps to occur.

Problem

In this lesson you are going to analyze what happens to the Crude Oil Futures in the first hour of trading when in the last 20 years a gap has occurred and the open is more than the previous day’s close by more than .50 cents. While on the same day, an OPEC meeting occurred. You will use a percent move study to see how the future performed from 10:00 am, at the open to 11:00 am, the end of the first trading hour. Other percent move studies will also show how the future performed the remainder of the day, from 11:00 am to 2:30 pm, and for the entire day as a whole from 10:00 am to 2:30 pm.

After the query is completed, the following text will appear within the Edit pane of the Query Builder window:

SHOW
FirstHr: percent_move from 10:00 am to 11:00 am of Close of CL
RestOfDay: percent_move from 11:00 am to 02:30 pm of Close of CL
DailyMv: percent_move from 10:00 am to 02:30 pm of Close of CL
WHEN
Time is 11:00 am
AND
Date is in "Intl_OPEC_Meet"
AND
The daily open of CL - The daily Close of CL 1 day ago is more than 0.5
AND
Date is within 20 years

Step-by-Step Solution

1. From the toolbar, select the Execution Units button and choose Minutes from the pull-down menu.

2. Type the symbol name CL into the Symbol field or select the Search Database button and open the folders in the Tree View to locate the symbol (open the folders for: Futures>Nymex). Keep the default Close as the column.

3. Select the Studies button and choose % move from the list and then select the OK button. In the Study: % move window select the Time Period button. In the Time Period window select the radial button next to the From-To buttons and then select the From button. Choose Condition> Date Time Condition from the pull-down menu. Select the Date or Time button then choose Time is from the list. Keep the exactly button default and change the time to 10:00 am. Select OK to close the Date Time Condition window. Next, select the To button and choose Condition> Date Time Condition from the pull-down menu. Select the Date or Time button then choose Time is from the list. Keep the exactly button default and change the time to 11:00 am. Select OK to close the Date Time Condition window. Select OK to close the Time Period window then select OK to close the Studies: % move window. Select the Add Attribute to Query button in the Query Builder to add the query statement to the Edit pane.

4. In the Edit pane change the label 1: to FirstHr:.

5. Repeat the steps above with the appropriate times to complete the next two query statements so that your query matches the following:

SHOW
FirstHr: percent_move from 10:00 am to 11:00 am of Close of CL
RestoOfDay: percent_move from 11:00 am to 02:30 pm of Close of CL
DailyMv: percent_move from 10:00 am to 02:30 pm of Close of CL

6. Now, set up the time condition Time is 11:00 am. From the WHEN pane, select the Date Time Condition button then select the Date or Time button. Choose Time is from the list. Keep the exactly setting then enter 11:00 am.

7. To enter another date condition, select the Add Condition button.

The Refresh Condition button will refresh the Date Time Condition window so that a new date or time condition can be constructed.
8. Next, select the **Date or Time** button then choose **Date is** from the list. Select the **within** button and choose **in file > server file**. Select the **Browse** button and open the folder for **Energy** and choose **Intl_OPEC_Meet** from the list. Select **OK** to close the window. Select **OK** to close the **Date Time Condition** window. The following shows the query:

```
SHOW
  FirstHr: percent_move from 10:00 am to 11:00 am of Close of CL
  RestofDay: percent_move from 11:00 am to 02:30 pm of Close of CL
  DailyMv: percent_move from 10:00 am to 02:30 pm of Close of CL
  WHEN
    Time is 11:00 am
    AND
    Date is in "Intl_OPEC_Meet"
```

9. From the **WHEN** pane, select the **Custom Event** button. For the **Left Attribute**, type **CL** in the **Symbol** field and choose **Open** from the **Column** field. Select the **Attribute Units** button from the **SHOW** pane and choose **Days** from the pull-down menu. Select the **OK** button to close the **Attribute Units** window. Notice that the **Attribute Units** button is now highlighted.

10. Select the **Arithmetic Operator** button and choose the radial button for **Subtract**. Type **CL** in the **Symbol** field and choose **Close** from the **Column** field. Select the **Attribute Units** button from the **SHOW** pane and choose **Days** from the pull-down menu. Select the **OK** button to close the **Attribute Units** window. Notice that the **Attribute Units** button is now highlighted. Select the **Time Offset** button and keep the **1 Day Ago** default. Select **OK** and notice that the **Time Offset** button is now highlighted to show that a selection was made. Select the **OK** button to close the **Left Attribute** window.

11. In the **Conditional Operator** pane, select the radial button next to **is exactly** and change **exactly** to **more than** then select the **Continue** button. In the **Right Attribute** pane select the **Variable** button and choose **Constant** from the pull-down menu. Type **.5** in the **Constant** field. Select **OK** to close the window and add the query statement to the **Edit** pane. The following shows the query so far:

```
SHOW
  FirstHr: percent_move from 10:00 am to 11:00 am of Close of CL
  RestofDay: percent_move from 11:00 am to 02:30 pm of Close of CL
  DailyMv: percent_move from 10:00 am to 02:30 pm of Close of CL
  WHEN
    Time is 11:00 am
    AND
    Date is in "Intl_OPEC_Meet"
    AND
    The daily open of CL - The daily Close of CL 1 day ago is more than 0.5
```

12. To add the final date condition, from the **WHEN** pane select the **Date Time Condition** button then select the **Date or Time** button and choose **Date is** from the list. Keep the **within** selection and change **1 Day** to **20 Year**. Select the **OK** button to close the window and return to the **Query Builder** window. The following shows the final query:

```
SHOW
  FirstHr: percent_move from 10:00 am to 11:00 am of Close of CL
  RestofDay: percent_move from 11:00 am to 02:30 pm of Close of CL
  DailyMv: percent_move from 10:00 am to 02:30 pm of Close of CL
  WHEN
    Time is 11:00 am
    AND
```

Date is in "Intl_OPEC_Meet"
AND
The daily open of CL - The daily Close of CL 1 day ago is more than 0.5
AND
Date is within 20 years

13. Select the New button from the toolbar to clear the Edit pane for the next lesson.

Language Lesson

In this lesson you used attribute units to force the Commodity Query to observe data in a different unit than what the execution units were set to. You used attribute units to compare the daily open of CL to the daily close of CL. Generally attribute units are used as the default time frequency for any attribute expressions built in Commodity Query. Time frequency can also be set for each defined attribute (local settings) using the Attribute Units button located in the SHOW pane of the Query Builder window.

The difference between the Attribute Units located under Options>Attribute Units in the menu bar and the Attribute Units located in the SHOW pane, is the version selected in the SHOW pane is specific to that one attribute and will override the Option>Attribute Units menu version. Attribute Units accessible from Options>Attribute Units in the menu bar will change the frequency of all attributes used either in SHOW attributes or within WHEN conditions custom events.

This query used a time offset to compare a price on our event date to a price on the day before. You used time offset to compare the daily open of CL on the event date to the daily close of CL on the day before the event date. The time offset menu selection is used to pick a date, relative to ‘today’ or the current date or time executed within the system. The simplest time offset takes the form of n time units [ago | later], such as “10 days ago” or “55 weeks later”. Time offset is commonly used to anchor a time period against the current execution date or time in Commodity Query.

Problem Solvers

Create a query that studies the percent move in the first hour of the day for the Natural Gas Future when the EIA releases the Gas Storage Report within the last 10 years.

The Gas Storage report comes out at 10:30 am EST but the time stamp on the data for CL is CST since the exchange it’s traded on is in Chicago.
CHAPTER 14

Back-Testing a Long-Only Moving Average Trading Strategy

Synopsis

Objectives

1. Introducing ORDER blocks.
2. Reiterating time offset.
3. Introducing ORDER options.

Market Brief

Prior to taking a position using an untried trading strategy most traders usually paper trade the strategy in order to identify whether or not the strategy is appropriate. The trader documents the entry price, monitors the trade, documents the price where the position closed out (that is, level where the stop loss, take profit or position close would trigger) and evaluates the strategy following several iterations of this process. The evaluation would take into account the overall profitability of the strategy, the maximum amount of draw down, average length of time the position kept the trader in the market, etc. Obviously the longer period of time the trader is able to paper trade the position the more information he or she would have about the strategy. Commodity Query has the ability to enhance the paper trade process by allowing researchers to evaluate systematic trading strategies over a long period of time.

At the beginning of this manual we explained that there are two major types of questions or queries that may be posed in the software. Up to this point you have spent a substantial amount of time using the SHOW/WHEN query. The SHOW/WHEN query provides quite a bit of utility and will be used for most of your research ideas. The other type of query, the ORDER query, is a very powerful research tool and will build onto your research ideas created by using the SHOW/WHEN query by back-testing your research strategies. The ORDER query allows you the ability to buy or sell your security when certain conditions exist and to exit out of your position when certain other conditions are present.

Problem

You are going to build a very simple long-only moving average system. This system will place a buy order for 10 natural gas contracts anytime the closing price of the contract crosses above the 1-month average of closing prices for that
contract and will exit out of the position anytime the closing price crosses below the 1-month average. Because you are using a continuous futures contract series (which does not really exist) you will need to roll your contracts. This means if you have a signal to buy 10 contracts and have not hit your exit condition you will sell out of the contract at expiration and buy the new front contract. The following shows how the completed query will look:

```
1: ORDER
  1.1: Buy 1 day later 10 contracts of NG
       Enter on the open
     WHEN
       Close of NG crosses above 1 month average of Close of NG
     EXIT
       Close of NG crosses below 1 month average of Close of NG
```

Step-by-Step Solution

Working within an ORDER Block

1. You will need to work within an ORDER block instead of a SHOW/WHEN. In the Query Builder window, select Tools > Add Query Block > ORDER from the menu bar.

2. Notice that the Query Builder window now includes an ORDER pane and EXIT pane in addition to the WHEN condition that you have used before.

Creating the Buy Order

1. In the ORDER pane, in the Trade pane, select Buy from the pull-down menu.

2. Enter 10 in the text field next to Contracts and type the symbol NG into the next text field. Before you exit the window, you need to offset the date on which you will purchase your contracts. You might expect Commodity Query to execute this query’s buy orders on the day after the condition is met because in the real world it is impossible to simultaneously calculate the closing price of a security and place an order for that security right at the close. Obviously, the simultaneous calculation and order placement would be impossible in the real world but would occur using Commodity Query. In order to place the order on the next day, you must use the time offset function. Select the Time Offset button.
3. Change the time offset settings to **1 Day Later** and select the **OK** button.

4. Next, you want to make sure that the order will be entered on the open of the day following the condition. In the **Enter/Exit** pane, select **Open** from the **Enter on the** pull-down list.
5. If your Buy Trade pane has 10 Contracts, NG, 1 Day Later and Enter on the Open highlighted, select the Enter button to accept these selections.

Setting the Entry Condition

1. The WHEN pane is used to establish the entry condition for an ORDER. You will buy 10 contracts anytime the closing price of contract crosses above the one-month average of the closing prices for the contract. This condition is created using a custom event condition. This custom event condition will require the completion of a left attribute (Close of NG), a conditional operator (crosses above) and a right attribute (one month average of Close of NG). In the WHEN pane select Condition and then choose Custom Event from the pull-down menu.

2. In the Custom Event window in the Left Attribute pane type in NG in the Symbol field and choose Close from the Column pull-down menu. If the Left Attribute pane has NG and Close highlighted, select the Continue button.

3. Within the Conditional Operator pane select crosses above and then select the Continue button.

4. In the Right Attribute pane, type NG in the Symbol field and choose Close as your Column. Select the Studies button and choose average from the list. In the Study: average window select the Time Period button. In the Time Period window, change 1 Day to 1 Month and select OK to close the Time Period window. The Studies button is highlighted to show that a selection was completed. Select OK to complete and close the Custom Event window.

Setting the Exit Condition

1. Our exit condition is going to be the same as our entry or WHEN condition except that, instead of selecting crosses above, you will choose crosses below for your conditional operator. In the Exit pane select the Condition button then choose Custom Event from the pull-down menu.

2. In the Left Attribute pane, type NG in the Symbol field and choose Close for the Column then select the Continue button.

3. In the Conditional Operator pane, select the radio button for crosses below then select the Continue button.

4. In the Right Attribute pane, type NG in the Symbol field and choose Close for the Column. Select the Studies button and choose average from the list. In the Study: average window select the Time Period button and change 1 Day to 1 Month and select OK to close the Time Period window. The Studies button is highlighted to show that a selection was completed. Select OK to complete and close the Custom Event window.
Setting the Rollover Policy

1. The query should now resemble the example illustrated in the problem above. You cannot execute your query, however, because you haven’t dealt with making sure that our futures contract will roll upon expiration. In the real world you would have to sell out of the front contract upon expiration and buy the back contract in order to stay in the trade. You can simulate this by changing the Entry & Exit ORDER options. From the toolbar, select the Execute Options button then select the ORDER tab. In the Entry & Exit pane for Rollover select Re-entry Number of Contracts from the pull-down menu.

2. Another ORDER option that is helpful to use is Print Reason for Trade located in the Report Details pane of the Execute Options (ORDER tab) window. Select the check box to activate the Print Reason for Trade option then select OK to close the window.

3. From the toolbar, select the Report button to execute the ORDER query. Notice that the statistical information on your trading activity appears at the top of the report with all of the transactions appearing on the lower portion of the report.
## Back-Testing a Long-Only Moving Average Trading Strategy

### P&L Summary Statistics

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Combined</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Trades</td>
<td>201.00</td>
</tr>
<tr>
<td>Number of Closed Trades</td>
<td>201.00</td>
</tr>
<tr>
<td>Number of Winning Trades</td>
<td>57.00</td>
</tr>
<tr>
<td>Percentage of Winning Trades</td>
<td>28.36</td>
</tr>
<tr>
<td>Max Consecutive Winning Trades</td>
<td>4.00</td>
</tr>
<tr>
<td>Avg Consecutive Winning Trades</td>
<td>1.27</td>
</tr>
<tr>
<td>Percentage of Trades at New High</td>
<td>8.96</td>
</tr>
<tr>
<td>Number of Losing Trades</td>
<td>144.00</td>
</tr>
<tr>
<td>Percentage of Losing Trades</td>
<td>71.64</td>
</tr>
<tr>
<td>Max Consecutive Losing Trades</td>
<td>14.00</td>
</tr>
<tr>
<td>Avg Consecutive Losing Trades</td>
<td>3.20</td>
</tr>
<tr>
<td>Percentage of Trades at New Low</td>
<td>1.99</td>
</tr>
</tbody>
</table>

| Average Trade Length | 10.32 |
| Average Winning Trade Length | 27.11 |
| Average Losing Trade length  | 3.67  |

| Total Number of Contracts | 2010.00 |
| Maximum Number of Contracts | 10.00  | 04/09/1990 |

| Average Profit per Trade      | 5027.37  |
| Average Profit per Winning Trade | 54022.81 |
| Average Profit per Losing Trade | 14366.67 |
| Ratio Average                  | 3.76     |
| Profit Factor                  | 1.49     |
| Pessimistic Return             | 1.19     |
| Performance Ratio              | 0.09     |

| Average Profit per Period     | 1.91     |
| Compound Average Profit per Period | 0.05   |
| Percentage of Periods at New High | 10.63  |
| Standard Deviation of Profit Return | 10.64 |
| Sharpe Ratio (est.)           | 0.10     |
| ZStat                          | 2.58     |
| Standard Error                | 431.02   |
| Standard Error Ratio          | 0.00     |
| Geometric Error Ratio         | 0.03     |

| Biggest Win                   | 536700.01 | 10/20/2005 |
4. There are several other key functions that can be used in your ORDER query. These functions include setting your stop loss and take profits for the trade. These concepts and others are more appropriate for intermediate training courses. For more information, see the Commodity Query Profit/Loss User Manual.

Language Lesson

In this lesson you pulled together several of the analytical functions you worked on in earlier lessons. In addition to the technical studies used in the query, the lesson introduced the basic Buy Trade window and the rollover options.

There are several very useful options available to enhance your ORDER query accessible from the Execute Options menu (to access the menu, select the Execute Options button from the toolbar). For example, there are options that will allow for slippage and commission for each trade.

Problem Solvers

Create the same profit-loss study as explained in this lesson but substitute the Palo Verde Electricity futures contract (EV).
CHAPTER15

Back-Testing Long & Short Moving Average Trading Strategies

Synopsis

Objectives

1. Introduction to multiple ORDER blocks.
2. Reiteration of the ORDER window.

Market Brief

A popular strategy used with momentum based trading systems is to close out an open position and initiate a reverse order upon a reverse signal. Typically, the reverse signal is the exit condition of the original trade.

Commodity Query has the ability to create multiple query blocks. You may create a compound query block by simply adding a new query block to your existing query.

Problem

You are going to build onto the query created in the preceding lesson by adding an additional query block to trigger a short position or a sell trade whenever the exit conditions of our buy trade are activated. This system will place a buy order for 10 natural gas futures contracts anytime the closing price of our contract crosses above the 1-month average of closing prices for that contract and will exit out of the position anytime the closing price crosses below the 1-month average. Additionally, the system will place a sell order for 10 natural gas contracts anytime the closing price of the contract crosses below the 1-month average of closing prices for that contract and will exit out of the position anytime the closing price crosses above the 1-month average. The following shows how the query will look when completed:

1. ORDER
Chapter 15: Back-Testing Long & Short Moving Average Trading Strategies

1.1: Buy 1 day later 10 contracts of NG  
   Enter on the open  
   WHEN  
   Close of NG crosses above 1 month average of Close of NG  
   EXIT  
   Close of NG crosses below 1 month average of Close of NG

2: ORDER  
2.1: Sell 1 day later 10 contracts of NG  
   Enter on the open  
   WHEN  
   Close of NG crosses below 1 month average of Close of NG  
   EXIT  
   Close of NG crosses above 1 month average of Close of NG

Step-by-Step Solution

Adding an Additional ORDER Query

1. In the Query Builder window, from the menu bar, select Tools>Add Query Block>ORDER. Notice that a second ORDER block appears within the Edit pane.

   1: ORDER  
   1.1: Buy 1 day later 10 contracts of NG  
       Enter on the open  
       WHEN  
       Close of NG crosses above 1 month average of Close of NG  
       EXIT  
       Close of NG crosses below 1 month average of Close of NG

   2: ORDER

2. In the Trade pane, select Sell from the pull-down menu.

3. Next, enter 10 next to the Contracts field and type the symbol NG into the Symbol text field. Before you exit the window, offset the date when the contracts will be sold. Select the Time Offset button and change the settings to 1 Day Later and select OK. Next, select Open from the Enter on the pull-down located in the Entry/Exit pane to ensure that the trade will be activated on the morning after the conditions are met. If the Trade pane has Sell, 10 Contracts, NG, 1 Day Later and Enter on the Open listed, select the Enter button to accept these selections.

The following shows your query progress:

   1: ORDER  
   1.1: Buy 1 day later 10 contracts of NG  
       Enter on the open  
       WHEN  
       Close of NG crosses above 1 month average of Close of NG  
       EXIT
Close of NG crosses below 1 month average of Close of NG

2. ORDER
   2.1: Sell 1 day later 10 contracts of NG
       Enter on the open

Setting Entry Conditions

1. In the previous lesson, it was mentioned that the WHEN pane for an ORDER block is used to establish the entry condition for our ORDER. In this lesson, you will sell 10 contracts anytime the closing price for the front S&P futures contract crosses below the 1-month average of the closing prices for the contract. From the WHEN pane select the Condition button then select Custom Event from the pull-down menu. In the Left Attribute pane, type NG in the Symbol field and choose Close from the Column field. Select the Continue button to proceed to the Conditional Operator pane.

2. Within the Conditional Operator pane select the radio button for crosses above and select crosses below from the pull-down menu. Select the Continue button to proceed to the Right Attribute pane.

3. In the Right Attribute pane, type NG in the Symbol field and choose Close as the Column. Select the Studies button and choose average from the list. In the Study: average window change 1 Day to 1 Month and select the OK button to close the window. Notice that the Studies button is highlighted to show that an entry was made. Select the OK button to enter the selections into the Edit pane and return to the Query Builder window.

Setting Exit Conditions

1. The exit condition is going to be the same as our entry condition except that, instead of selecting crosses below, you will choose crosses above for your conditional operator. In the Exit pane select the Condition button and choose Custom Event from the pull-down menu.

2. In the Left Attribute pane, type NG in the Symbol field and choose Close for the Column then select the Continue button.

3. In the Conditional Operator pane, select the radio button for crosses above and select the Continue button.

4. In the Right Attribute pane, type NG in the Symbol field and choose Close for the Column. Select the Studies button and choose average from the list. In the Studies: average window, select 1 month and select the OK button to close the window. Notice that the Studies button is highlighted to show that you have made an entry. Select the OK button to add the entries to the Edit pane and return to the Query Builder window.

5. The rollover options have not been reset, so go ahead and execute the query by selecting the Report button from the toolbar. The execution time for the query will dramatically increase because of the addition of the new query block.
### COMMODITY QUERY ENERGY TRAINING GUIDE

**Chapter 15: Back-Testing Long & Short Moving Average Trading Strategies**

#### P&L Summary Statistics

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Combined</th>
<th>Long</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Trades</td>
<td>405.00</td>
<td>201.00</td>
</tr>
<tr>
<td>Number of Closed Trades</td>
<td>405.00</td>
<td>201.00</td>
</tr>
<tr>
<td>Number of Winning Trades</td>
<td>111.00</td>
<td>57.00</td>
</tr>
<tr>
<td>Percentage of Winning Trades</td>
<td>27.41</td>
<td>28.36</td>
</tr>
<tr>
<td>Max Consecutive Winning Trades</td>
<td>4.00</td>
<td>4.00</td>
</tr>
<tr>
<td>Avg Consecutive Winning Trades</td>
<td>1.32</td>
<td>1.27</td>
</tr>
<tr>
<td>Percentage of Trades at New High</td>
<td>5.19</td>
<td>8.96</td>
</tr>
<tr>
<td>Number of Losing Trades</td>
<td>294.00</td>
<td>144.00</td>
</tr>
<tr>
<td>Percentage of Losing Trades</td>
<td>72.59</td>
<td>71.64</td>
</tr>
<tr>
<td>Max Consecutive Losing Trades</td>
<td>14.00</td>
<td>14.00</td>
</tr>
<tr>
<td>Avg Consecutive Losing Trades</td>
<td>3.50</td>
<td>3.20</td>
</tr>
<tr>
<td>Percentage of Trades at New Low</td>
<td>1.48</td>
<td>1.99</td>
</tr>
<tr>
<td>Average Trade Length</td>
<td>10.50</td>
<td>10.32</td>
</tr>
<tr>
<td>Average Winning Trade Length</td>
<td>26.53</td>
<td>27.11</td>
</tr>
<tr>
<td>Average Losing Trade Length</td>
<td>4.41</td>
<td>3.67</td>
</tr>
<tr>
<td>Total Number of Contracts</td>
<td>4050.00</td>
<td>2010.00</td>
</tr>
<tr>
<td>Maximum Number of Contracts</td>
<td>10.00 04/09/1990</td>
<td>10.00 04/09</td>
</tr>
<tr>
<td>Average Profit per Trade</td>
<td>1877.28</td>
<td>5027.37</td>
</tr>
<tr>
<td>Average Profit per Winning Trade</td>
<td>46263.97</td>
<td>54022.81</td>
</tr>
<tr>
<td>Average Profit per Losing Trade</td>
<td>14880.95</td>
<td>14366.67</td>
</tr>
<tr>
<td>Ratio Average</td>
<td>3.11</td>
<td>3.76</td>
</tr>
<tr>
<td>Profit Factor</td>
<td>1.17</td>
<td>1.49</td>
</tr>
<tr>
<td>Pessimistic Return</td>
<td>1.00</td>
<td>1.19</td>
</tr>
<tr>
<td>Performance Ratio</td>
<td>0.04</td>
<td>0.09</td>
</tr>
<tr>
<td>Average Profit per Period</td>
<td>2.03</td>
<td>1.96</td>
</tr>
<tr>
<td>Compound Average Profit per Period</td>
<td>0.01</td>
<td>0.05</td>
</tr>
<tr>
<td>Percentage of Periods at New High</td>
<td>12.08</td>
<td>10.89</td>
</tr>
<tr>
<td>Standard Deviation of Profit Return</td>
<td>11.43</td>
<td>10.77</td>
</tr>
<tr>
<td>Sharpe Ratio (est.)</td>
<td>0.18</td>
<td>0.18</td>
</tr>
<tr>
<td>ZStat</td>
<td>2.55</td>
<td>2.58</td>
</tr>
<tr>
<td>Standard Error</td>
<td>730.39</td>
<td>462.28</td>
</tr>
</tbody>
</table>
Language Lesson

This lesson focused on creating compound query blocks. Another interesting query block to add on to this lesson would be a SHOW/WHEN query so that you could graph the cumulative equity curve of this trading system. From the menu bar, select Tools>Add Query Block>SHOW WHEN. From the SHOW pane select the Profit Loss button to add final statistics to the query.

From the Profit Loss Statistics window, select Final Statistics from the Profit-Loss Statistics pull-down menu then check the box for Equity. Select the OK button to close the window. Notice that the Profit Loss button is highlighted to show that an entry was made. Select the OK button to add the entry to the query in the Edit pane.

After the query is completed with the SHOW/WHEN statement, the query will match the following:

1: ORDER
  1.1: Buy 1 day later 10 contracts of NG
       Enter on the open
       WHEN
       Close of NG crosses above 1 month average of Close of NG
       EXIT
       Close of NG crosses below 1 month average of Close of NG
   2: ORDER
    2.1: Sell 1 day later 10 contracts of NG
         Enter on the open
         WHEN
         Close of NG crosses below 1 month average of Close of NG
         EXIT
         Close of NG crosses above 1 month average of Close of NG

SHOW
1: equity

As you probably guessed it is possible to add an infinite number of query blocks to the research study. A common Commodity Query research technique is to create an advanced allocation process whereby new ORDER blocks representing unique trading strategies will be added to create a smoothed equity curve.
Problem Solvers

Create the same profit-loss study as explained in this lesson but substitute the Palo Verde Electricity futures contract (EV).
CHAPTER 16

Using "My Queries" to Store Frequently Used Queries

Synopsis

Objectives

1. Create a My Queries button.
2. Learn about the Templates button.

Market Brief

Many queries are useful to run on a daily or frequent basis. The Best Match Analog is a query that is quite useful in comparing the recent trading pattern of a symbol and finding a historical period in time that is highly correlated to what is occurring now. When Commodity Query is installed, this particular query is provided under the My Queries pane for your convenience. Once a query button is created under the My Queries pane the user can select the button for the query and the graph or report for the query will generate depending on which one you designated to generate. There is no need to locate and open the query file and then run the graph or report on the query. This area makes retrieving and running the results on your favorite queries quite simple.

Problem

In this lesson, you will save the following query under the My Queries pane. This query shows the spread between the front contract and the 6th contract for Nymex Natural Gas over the last year.

SHOW
1: Close of NG - Close of NG_06
WHEN
Chapter 16: Using "My Queries" to Store Frequently Used Queries

Date is within 1 year

Step-by-Step Solution

1. In the SHOW pane of the Query Builder window type NG into the Symbol field and choose Close from the Column pull-down menu.

2. Select the Arithmetic Operator button then select the radial button for Subtract. In the Symbol field enter NG_06 for the symbol name then choose Close from the Column pull-down menu. Select the Add Attribute to Query button to add the query statement Close of NG - Close of NG_06 to the Edit pane and close the Arithmetic Operator window.

3. For the WHEN condition select the Date Time Condition button then select the Date or Time button and select Date is. Change the Day to Year so that the statement is Date is within 1 Year. Select the OK button to close the Date Time Condition window and add the WHEN condition to the query in the Edit pane. The following shows the query progress:

   SHOW  
   1: Close of NG - Close of NG_06  
   WHEN  
   Date is within 1 year

4. Next, select Tools > My Queries > Add Current Query from the menu bar. The Add Current Query window opens. In the Query Name pane type NG Spread for the query name. Ensure that the radial button for Graph is selected in the Action Event pane. Select the Save button and note that there is a new button entry under My Queries called NG Spread.

   ![My Queries](image)
   ![NG Spread](image)

When selecting this button in the future the graph will run automatically.

Language Lesson

The Best Match Analog query that was mentioned in the "Market Brief" section can be edited two ways. You can right-click on the button in the My Queries pane and select View Query to make manual edits in the query window. However, this is a complex query and manual editing requires a good understanding of the query. The preferred alternative is to use the Templates button on the toolbar. The Templates feature provides an easy way to customize the Best Match Analog and the Threshold Analog queries. You can also run the customized analogs from this location eliminating the need to open the analog in the query window at all.
Problem Solvers

Save the query below in the My Queries pane as "CL Spread".

SHOW
1: Close of CL - Close of CL_06
WHEN
Date is within 1 year

When completed, select the CL Spread button to run this query as a graph.
CHAPTER 17

Bringing Data into Excel from Commodity Query

Synopsis

Objectives

1. Bringing your results into an Excel spreadsheet.
2. Setting options for copying/pasting into Excel.

Market Brief

It is easy to share analysis between Commodity Query and popularly used programs such as Microsoft Excel®. Just select the Paste to Excel button located at the bottom of your Report window to copy your query results into an Excel spreadsheet for further analysis. In addition, there are option settings in the User Preferences menu that control how the results are brought into Excel. This lesson steps you through the process of bringing results into Excel and shows how to change the Excel option settings.

Problem

In this lesson, you are going to copy the results of a query into Microsoft Excel. Specifically, an Commodity Query report containing the last month of closing prices for the front continuous Natural Gas futures contract will be copied and then pasted into an Excel spreadsheet. Before you get started working the steps for the solution, take a look at the section below on the "Excel Option Settings".

Excel Option Settings

There are three Excel option settings in the User Preferences menu. To access the User Preferences menu, select Options > User Preferences from the menu bar.
Excel Pane

For these options, Excel must be running with a workbook open to receive the data from the application. The following describes the three Excel options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Table Results to Clipboard</td>
<td>This option allows the user to put the Report results in another application. This option is checked (activated) by default.</td>
</tr>
<tr>
<td>Send Paste Command to Excel</td>
<td>This option will paste the results of a Report into an open Excel worksheet.</td>
</tr>
<tr>
<td>Send New Worksheet and Paste Command to Excel</td>
<td>Creates a new worksheet in Excel and pastes the results of a Report into the new worksheet.</td>
</tr>
</tbody>
</table>

Step-by-Step Solution

1. Create a SHOW/WHEN Query that will SHOW the closing price for the front continuous Natural Gas futures contract (Close of NG) WHEN the date is within the last month. After you have completed the query, the following text will appear within the Edit pane of the Query Builder window:

   SHOW
   1: Close of NG
   WHEN
   Date is within 1 month

2. Execute an Commodity Query report by selecting the Report button from the toolbar.

3. To copy and paste the report in Excel open the Excel program and select Ctrl+V from the keyboard or Edit>Paste to paste the selection.

   In Commodity Query, if the Copy Table Results to Clipboard option is unchecked the report results can still be pasted into an Excel spreadsheet by selecting the Paste to Excel button located at the bottom of the Report window.

Problem Solvers

Populate an Excel Spreadsheet with the last month of closing prices for the front continuous Crude Oil futures contract.
CHAPTER 18

Problem Solver Answers

The following lists the answers to the problem solver questions for each chapter.

Problem Solver, Chapter 3: Event-Driven Analysis using the Query Wizard

Question

Create a query using the Query Wizard that shows what happens to the Natural Gas Futures contract 1 weekend 2 weeks later when the close price is up extra big and the day before it made a new 52-week low.

Answer

SHOW
t + 1: percent_move from today to 1 week later of NG
t + 2: percent_move from today to 2 weeks later of NG
WHEN
  1 day ago
    low of NG is less than 52 week lowest of low of NG 1 value ago
  AND
  1 value percent_move of NG is more than
    (30 day average of 1 value percent_move of NG +
    3 * 30 day std_dev of 1 value percent_move of NG)

Problem Solver, Chapter 4: Event-Driven Analysis using the Query Wizard Date Events

Question

Create a query using the Query Wizard that shows what happens to the Crude Oil Futures contract each day over the next 3 days when the EIA (formerly DOE) Petroleum report comes out.
Answer

SHOW
  t + 1; percent_move from today to 1 day later of CL
  t + 2; percent_move from today to 2 days later of CL
  t + 3; percent_move from today to 3 days later of CL
WHEN
  Date is in "USA_DOE_Petro"

Problem Solver, Chapter 5: Basic Pricing Graphs

Questions

1. Construct a query that will graph the closing price for the Crude Oil futures contract.

2. Construct a query that will graph the closing price for the Palo Verde futures contract.

Answers

1. SHOW
   1: Close of CL

2. SHOW
   1: Close of HO

Problem Solver, Chapter 6: Limiting the Graph to a Relevant Period of Time

Questions

1. Construct a query to graph the bar for the Crude Oil futures contract as well as the daily range for the last 2 years.
2. Construct a query to graph the bar for the Heating Oil futures contract as well as the daily range for the last 52 weeks.

Answers

1. `SHOW
   1: BAR of CL
   2: range of CL
   WHEN
   Date is within 2 years`

2. `SHOW
   1: BAR of HO
   2: range of HO
   WHEN
   Date is within 52 weeks`

Problem Solver, Chapter 7: Using a Technical Indicator with a Price Graph

Questions

1. Create a 1-month correlation study of the Natural Gas futures contract (NG) and the Crude Oil contract for the last year.

2. Create a 2-week correlation study of the Henry Hub SpotGas, Index (IGBBL21) and Transco 45 (IGBBU00) for the last 6 months.

Answers

1. `SHOW
   1: 1 month correlation of NG and CL
   WHEN
   Date is within 1 year`

2. `SHOW
   1: 2 week correlation of Index of IGBBL21 and Index of IGBBU00
   WHEN`
Problem Solver, Chapter 8: Basic Event-Driven Analysis using Date Conditions

Questions

1. Create a study that analyzes the 1-week percent move of the Natural Gas (NG) contract following all OPEC meeting dates falling after 1993.

2. Create a study that analyzes the 1-week move of the Heating Oil (HO) contract leading up to all U.S. holidays.

Answers

1. 
   SHOW
   1: percent_move from today to 1 week later of NG
   WHEN
   Date is in "Intl_OPEC_Meet"
   AND
   Date is after 1993

2. 
   SHOW
   1: move from today to 1 week ago of HO
   WHEN
   Date is any holiday

Problem Solver, Chapter 9: Basic Event-Driven Analysis using Market Conditions

Questions

1. Create a study that analyzes the 1-week move of the Natural Gas (NG) contract following all OPEC meeting dates falling after 1993 whenever the close price for the contract is more than the open on the date of the meeting.

2. Create a study that analyzes the 1-week move of the Heating Oil (HO) contract following all OPEC meeting dates falling after 1993 whenever the close price for the contract is more than the open on the date of the meeting.
Answers

1. SHOW
   1: move from today to 1 week later of NG
   WHEN
   - Date is after 1993
   AND
   - Date is in "Intl_OPEC_Meet"
   AND
   - Close of NG is more than Open of NG

2. SHOW
   1: move from today to 1 week later of HO
   WHEN
   - Date is in "Intl_OPEC_Meet"
   AND
   - Date is after 1993
   AND
   - Close of HO is more than Open of HO

Problem Solver, Chapter 10: Event-Driven Analysis using Weather Data

Question

For any date in December, January or February following 1990 where the low temperature at the NewYork LaGuardia Airport, is down over 20% for two days in a row, show the move from this date (today) to 3 days later of the front Natural Gas contract (NG).

Answer

SHOW
1: move from today to 3 days later of NG
WHEN
- Date is after 1990
AND
- LowTemp of NEW.YORK.LA.GUARDIA.NY is down more than 20% 2 days
AND
  {  
  - Date is December
  OR
  - Date is January
  OR  
  - Date is February
  }


Problem Solver, Chapter 11: Event-Driven Analysis on Multiple Symbols

Question

Create a query that looks at what happens in terms of percent move 1, 2, and 3 days later to the Natural Gas and Heating Oil Futures when the Winter in Chicago is colder than expected.

Answer

LET
   @MyList = NG, HO
SHOW
   1: percent_move from today to 1 day later  of @MyList
   2: percent_move from today to 2 days later  of @MyList
   3: percent_move from today to 3 days later  of @MyList
WHEN
   Date is last day of February
   AND
   average ( Hightemp of CHICAGO.OHARE.II + Lowtemp of CHICAGO.OHARE.II, 2 calendar months ) / 2 is less than average from begin_of_time to today
   of IF
   Date is from January to February
   THEN (Hightemp of CHICAGO.OHARE.II + Lowtemp of CHICAGO.OHARE.II) / 2
   ENDIF

Problem Solver, Chapter 12: Analysis using Intraday Data

Question

Construct a query that uses the intraday data to indicate the exact minute the low occurred for the continuous Crude Oil Future contract for the most recent trading date.

Answer

SHOW
   MinuteLow: Low of CL
   Lowest: lowest from 08:30 am to 03:15 pm of Low of CL
   Indicator: IF
Problem Solver, Chapter 13: Event-Driven Analysis using Intraday Data

Question

Create a query that studies the percent move in the first hour of the day for the Natural Gas Future when the EIA releases the Gas Storage Report within the last 10 years.

The Gas Storage report comes out at 10:30am EST but the time stamp on the data for CL is CST since the exchange it is traded on is in Chicago.

Answer

SHOW
  FirstHr: percent_move from 10:00 am to 11:00 am of Close of NG
  WHEN
    Time is 11:00 am
  AND
    Date is in "USA_EIA_Gas_Storage"
  AND
    Date is within 10 years

Problem Solver, Chapter 14: Back-Testing a Long-Only Moving Average Trading Strategy

Question

Create the same profit-loss study as explained in the lesson but substitute the Palo Verde Electricity futures contract (the symbol name is “EV”).
Answer

1: ORDER
   1.1: Buy 1 day later 10 contracts of EV
       Enter on the open
       WHEN
       Close of EV crosses above 1 month average of Close of EV
       EXIT
       Close of EV crosses below 1 month average of Close of EV

Problem Solver, Chapter 15: Back-Testing Long & Short Moving Average Trading Strategies

Question

Create the same profit-loss study as explained in the lesson but substitute the Palo Verde Electricity futures contract (the symbol name is “EV”).

Answer

1: ORDER
   1.1: Buy 1 day later 10 contracts of EV
       Enter on the open
       WHEN
       Close of EV crosses above 1 month average of Close of EV
       EXIT
       Close of EV crosses below 1 month average of Close of EV

2: ORDER
   2.1: Sell 1 day later 10 contracts of EV
       Enter on the open
       WHEN
       Close of EV crosses below 1 month average of Close of EV
       EXIT
       Close of EV crosses above 1 month average of Close of EV
Problem Solver, Chapter 16: Using "My Queries" to Store Frequently Used Queries

Question

Save the query below in the My Queries pane as "CL Spread".

SHOW
1. Close of CL - Close of CL_06
WHEN
  Date is within 1 year

When completed, select the CL Spread button to run this query as a graph.

Answer

The CL Spread button will be in the My Queries pane and when clicked on, the resulting graph displays.
Problem Solver, Chapter 17: Bringing Data into Excel from Commodity Query

Question

Populate an Excel Spreadsheet with the last month of closing prices for the continuous Crude Oil futures contract.

Answer

The following shows the query:

SHOW
  1: Close of CL
WHEN
  Date is within 1 month
The following shows a portion of the answers in Excel:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Date</td>
<td>Day</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1/8/2007</td>
<td>Mon</td>
<td>56.09</td>
</tr>
<tr>
<td>4</td>
<td>1/9/2007</td>
<td>Tue</td>
<td>55.64</td>
</tr>
<tr>
<td>5</td>
<td>1/10/2007</td>
<td>Wed</td>
<td>54.02</td>
</tr>
<tr>
<td>6</td>
<td>1/11/2007</td>
<td>Thu</td>
<td>51.88</td>
</tr>
<tr>
<td>7</td>
<td>1/12/2007</td>
<td>Fri</td>
<td>52.99</td>
</tr>
<tr>
<td>8</td>
<td>1/15/2007</td>
<td>Mon</td>
<td>NaN</td>
</tr>
<tr>
<td>9</td>
<td>1/16/2007</td>
<td>Tue</td>
<td>51.21</td>
</tr>
<tr>
<td>10</td>
<td>1/17/2007</td>
<td>Wed</td>
<td>52.24</td>
</tr>
<tr>
<td>11</td>
<td>1/18/2007</td>
<td>Thu</td>
<td>50.48</td>
</tr>
<tr>
<td>12</td>
<td>1/19/2007</td>
<td>Fri</td>
<td>51.99</td>
</tr>
<tr>
<td>13</td>
<td>1/22/2007</td>
<td>Mon</td>
<td>51.13</td>
</tr>
<tr>
<td>14</td>
<td>1/23/2007</td>
<td>Tue</td>
<td>55.04</td>
</tr>
<tr>
<td>15</td>
<td>1/24/2007</td>
<td>Wed</td>
<td>55.37</td>
</tr>
<tr>
<td>16</td>
<td>1/25/2007</td>
<td>Thu</td>
<td>54.23</td>
</tr>
<tr>
<td>17</td>
<td>1/26/2007</td>
<td>Fri</td>
<td>55.42</td>
</tr>
<tr>
<td>18</td>
<td>1/29/2007</td>
<td>Mon</td>
<td>54.01</td>
</tr>
<tr>
<td>19</td>
<td>1/30/2007</td>
<td>Tue</td>
<td>56.97</td>
</tr>
<tr>
<td>20</td>
<td>1/31/2007</td>
<td>Wed</td>
<td>58.14</td>
</tr>
<tr>
<td>21</td>
<td>2/1/2007</td>
<td>Thu</td>
<td>57.3</td>
</tr>
<tr>
<td>22</td>
<td>2/2/2007</td>
<td>Fri</td>
<td>59.02</td>
</tr>
<tr>
<td>23</td>
<td>2/5/2007</td>
<td>Mon</td>
<td>58.74</td>
</tr>
<tr>
<td>24</td>
<td>2/6/2007</td>
<td>Tue</td>
<td>58.88</td>
</tr>
<tr>
<td>25</td>
<td>2/7/2007</td>
<td>Wed</td>
<td>57.71</td>
</tr>
<tr>
<td>26</td>
<td></td>
<td>Avg</td>
<td>54.9318</td>
</tr>
<tr>
<td>27</td>
<td>AvgPos</td>
<td>54.9318</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>AvgNeg</td>
<td>NaN</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>PctPos</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>PctNeg</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Maximum</td>
<td>59.02</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Minimum</td>
<td>50.48</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>StdDev</td>
<td>2.7268</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>ZStat</td>
<td>20.1452</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Variance</td>
<td>7.4354</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td>Occurrences</td>
<td>23</td>
</tr>
</tbody>
</table>
CHAPTER19

Glossary

**Arithmetic Operator** – Attributes or data series can be combined using simple arithmetic operations like addition, subtraction, division, etc., through the use of an arithmetic operator.

**Attribute** - Attribute is a complete description of a time series - an array of numbers, organized in chronological order, usually with a regular frequency.

**Attribute Units** - Attribute unit is the default time-frequency for any attribute expression built in Commodity Query.

**Condition** – Condition provides the ability to restrict the results of a query or question about the markets to specific dates and times of interest.

**Condition Connector** – The condition connectors, such as AND, OR, XOR, AND NOT, are used to create compound conditions within a query (i.e. 1st Condition AND 2nd Condition).

**Custom Event** - Conditions that incorporate Attributes are built using the Custom Events button accessible from the WHEN pane of the Query Builder. The custom event general format is: \(<\text{Left Attribute}>\ <\text{Conditional Operator}>\ <\text{Right Attribute}>\)

**Date Time Condition** – The Date Time Condition provides the ability to restrict the results of a query or question about the markets to specific dates or times.

**Date Event** - Refine a query using date events accessible from the Query Wizard. For a description of each date event, see the “Date Events” appendix in the Commodity Query User Guide.

**Edit Pane** – The query displays within this pane after building a query using the Query Builder or the Query Wizard.

**Execution Units** - Execution units determine the time-frequency over which queries will range through the database looking for answers. The default frequency is daily but may be changed to any frequency from 1 minute to any number of years.

**How Do I Say** - Use the list of examples in the How Do I Say window as a starting point for building and customizing your own queries. Queries may be saved and added to this window for reuse. To access the list of examples, select the How Do I Say button from the toolbar.

**Label** – The column title in the report or graph is created manually by editing the labels in the Edit pane. For example, in the query statement 1: Close of NG the text 1: is the label and may be changed to any name, such as Henry Hub:.

**LET** - To invoke the LET function, select Tools>LET from the menu bar. The LET statement allows the user to assign properties to variables and is defined in the query above the query block. This variable may be used to range the query over different symbols or values, used in place of complex query statements, or query data from a file. The variable may be used as a short-hand substitute that can be used again and again throughout the query.

**Market Event** - Refine a query using market events. For a description of each market event, see the "Market Events" appendix in the Commodity Query User Guide.
**ORDER** - Much of the power of the P/L module derives from the notion of an order block. An order block consists of a set of trade orders (buy, sell, and/or exit) and conditions. The trade orders are ‘placed’ when the conditions are satisfied. To create an order block, from the menu bar select **Tools>Add Query Block>ORDER**.

**Query** - English-like questions created to poll the database. Queries are composed of SHOW/WHEN and ORDER blocks.

**Query Builder** – Guides the user through the process of building a correct query using the Commodity Query language.

**Query Wizard** - Use this feature to build complex queries using pre-defined market and date events.

**Relation** – A data structure represented in Commodity Query by a the unique identifiers consisting of a symbol and column.

**Search Database** – Select the **Search Database** button to locate symbols and columns in the database. In the **Shortcut** menu, create short-cuts to often used symbols. You can use the **Tree View** menu to locate specific symbols and add them to your query. The **Search** menu allows searches by symbol or by description and can be set to narrow the search to specific categories in the database.

**SHOW/WHEN** – To invoke the SHOW/WHEN function (default), select **Tools>Add Query Block>SHOW WHEN** from the menu bar. The SHOW/WHEN query allows a user to query what happens to the market when certain conditions are present. Or stated another way, the SHOW/WHEN query is constructed as a compound sentence which, in general terms states “Show me what happens to my specified data series whenever a defined condition (or conditions) are true.” This type of query requires the user to specify both the market of interest and the condition or time period for which the user expects to see the market displayed. The ‘market of interest’ is created by defining what it is the user wants to “SHOW”. This may be accomplished by either making certain menu selections using the **SHOW** pane of the **Query Builder** or by typing in the SHOW criteria directly into the **Edit** pane. Likewise, the condition or time period for which the user expects to see the market displayed is created by using the **WHEN** pane of the **Query Builder** or by typing in the WHEN criteria directly into the **Edit** pane.

**Templates** - Morningstar Commodity Data provides a list of pre-built queries (templates) that may be modified for your own use. For example, the **Templates** menu shows how to create the complicated and often used analog query. To access the list of templates, select the **Templates** button from the toolbar. Select a template from the pull-down list to build a query. Enter the parameters and select the **Add to Query** button to paste the modified query into the **Edit** pane of the **Query Builder** window. Select the **Return to Query Builder** button if you want to exit the **Templates** window.

**Time Offset** - The **Time Offset** menu is used to pick a date, relative to today or the current date executed within the system.
Index

A
Add Attribute to Query Button, 8
Arithmetic Operator, 28
Attribute, 20

C
Column, 19
Condition
  Date, 19
Continuous, 22
Copy Table Results to Clipboard, 88, 88
Custom Event, 44, 44, 45

D
Date, 19
Date Condition, 29
Date Event, 7

E
Edit Pane, 8, 24
Excel
  Copy Table Results to Clipboard, 88, 88
  Send New Worksheet and Paste Command to Excel, 88
Execute Options
  ORDER, 73
Execution Units, 31

G
Graph, 22, 24, 30
  Options, 24, 30, 36

H
How Do I Say, 58

L
Label, 31
LET, 56, 59
Logical Operator, 41, 44

M
Market Event, 8

N
NaN, 22

O
ORDER, 5

Q
Query Block, 77
Query Builder, 8
  WHEN, 9
Query Wizard
  SHOW, 5
  WHEN, 7
QueryBuilder
  SHOW, 8

R
Re-entry Number of Contracts, 73
Report, 22, 24
Restart Attribute Button, 8
Rollover Policy, 73

S
Search Database, 20, 20
Send New Worksheet and Paste Command to Excel, 88
Server Macros, 37
SHOW/WHEN, 5
Starting Commodity Query, 2
Studies, 35
Symbol, 19

T
Time Expressions, 37
Time Offset, 40
Time Period Window, 37

U
User Preferences
  Excel, 88